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Instruction Sheet Learning Guide #9 

 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics: 

 word-processing software  

 word-processing application 

 Identifying document purpose, audience and presentation  

 Identifying organizational requirements  

 Matching document with software functions  

This guide will also assist you to attain the learning outcome stated in the cover page. Specifically, 

Upon completion of this Learning Guide, you will be able to: 

 Select word-processing software appropriate to perform activity 

 Open word-processing application, create document and add data according to 

information requirements 

 Identify document purpose, audience and presentation requirements, and clarify with 

personnel as required 

 Identify organizational requirements for text-based business documents, and design 

document structure and layout to ensure consistency of style and image 

 Match document requirements with software functions to provide efficient production of 

documents 

 

Learning Instructions: 

1. Read the specific objectives of this Learning Guide. 

2. Follow the instructions described below 3 to 5. 

3. Read the information written in the information ―Sheet 1 to Sheet 5‖. 

4. Accomplish the ―Self-check 1 to Self-check 5‖ in page -5, 8, 12, 15 and 419 respectively. 

5. If you earned a satisfactory evaluation from the ―Self-check‖ proceed to ―to the next. 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                        

                                                                                                         

Information Sheet-1 
word-processing software  

1.1 INTRODUCTION TO COMPUTER 

Computer is Computer is an electronic device that is designed to work with Information. The 

term computer is derived from the Latin term ‗computer‘, this means to calculate or programmable 

machine. Computer cannot do anything without a Program. It represents the decimal numbers 

through a string of binary digits. The Word 'Computer' usually refers to the Center Processor Unit 

plus Internal memory. 

1.2 Word Processing software 

Word processing software is used to manipulate a text document, such as a resume or a report. 

You typically enter text by typing, and the software provides tools for copying, deleting and various 

types of formatting.  

 Some of the functions of word processing software include: 

 Creating, editing, saving and printing documents. 

 Copying, pasting, moving and deleting text within a document. 

 Formatting text, such as font type, bolding, underlining or italicizing. 

 Creating and editing tables. 

 Inserting elements from other software, such as illustrations or photographs. 

 Correcting spelling and grammar. 

Below is an example of a blank Microsoft Word window with areas 

of the window highlighted. 

http://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer
http://ecomputernotes.com/fundamental/number-system/bit


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Figure 1. Microsoft Word processer 

 Examples of word processor programs 

Although Microsoft Word is the most popular word processor 

available, other options are available.  

Below is a listing of different word processors in alphabetical order. 

 Abiword. 

 Apple iWork - Pages. 

 Apple Text Edit - Apple macOS included word processor. 

 Corel WordPerfect. 

 Google Docs (online and free). 

 LibreOffice -> Writer (free). 

 Microsoft Office -> Microsoft Word. 

 Microsoft Works (discontinued). 

 OpenOffice -> Writer (free). 

 

https://www.computerhope.com/jargon/a/abiword.htm
https://www.computerhope.com/comp/apple.htm
https://www.computerhope.com/jargon/i/iwork.htm
https://www.computerhope.com/jargon/t/textedit.htm
https://www.computerhope.com/comp/corel.htm
https://www.computerhope.com/jargon/g/google-docs.htm
https://www.computerhope.com/jargon/l/libreoff.htm
https://www.computerhope.com/comp/msoft.htm
https://www.computerhope.com/jargon/o/office.htm
https://www.computerhope.com/jargon/m/microsoft-word.htm
https://www.computerhope.com/jargon/m/msworks.htm
https://www.computerhope.com/jargon/o/openoffi.htm


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -1 Written Test 

 

Directions: - Answer all the questions listed below. Use the Answer sheet provided in the next 

page. 

1. What is word processing software? (4 points) 

2. Write  the functions of word processing software (6 points) 

 

 

 

 

 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 10 points  Unsatisfactory - below 10points  

You can ask your teacher for the copy of the correct answers. 

 Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-2 word-processing application 

 

2.1 Word processing applications 

A word processing application, such as Microsoft Word or Corel WordPerfect, is very good at 

working with basic text. If you want to type fast, check your spelling and grammar, automate 

repetitive typing tasks, create outlines, track changes to the text, write reports with footnotes, make 

and organize tables of data, and print to desktop printers, then you should choose a word 

processor as your application. 

2.2 Types of Word Processing Applications 

A word processor is an application that allows you to type in, edit, format, save, and print text. The 

text shows on screen the same or very similar to how it will appear in hard copy format. Word 

processors are commonly used by students, writers, authors, desktop publishing professionals and 

layout artists. Before you purchase a word processor, try several out. Some can be downloaded for 

free, and other can be downloaded for a trial period.  

 

Figure 1. Word processer software application 

1. Microsoft Word 

One of the most well-known and widely used word processing applications on the market is 

Microsoft Word. Word has more than 90 percent of the word processing market and more than 450 

million users. Microsoft Corp. first released this program to the market in 1989, and since then 

there have been a number of upgrades to the software.  

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

2. WordPerfect 

WordPerfect is a word processing application from Corel Corp... WordPerfect was popular in the 

early 1990s. It is best for writing simple essays and articles. Though it isn't used as much today, 

WordPerfect is compatible with Microsoft Word, meaning that you can open and edit WordPerfect 

files in the Word program, then save them as WordPerfect files again. WordPerfect also can be 

used for formatting and laying out documents. 

3. Lotus Word Pro  

If you use Lotus Notes or Lotus 1-2-3--common in corporate environments--Lotus Word Pro is an 

ideal program for your word processing needs. This program works in concert with Lotus 

applications to allow you to create and distribute formatted text documents.  

4. IWork Pages 

Pages is a word processing program offered by Apple Incorporated, so if you own a Mac computer 

this might be the ideal option for your needs. It is a part of Apple's iWork suite of programs. Pages 

allows you to perform basic word processing functions--writing and formatting--as well as more 

complex graphical layout actions. You can open and save Pages files in Microsoft Word. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -2 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. List the types of Word Processing Applications. (8 points) 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 8 points  Unsatisfactory - below 8 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-3 Identifying document purpose, audience and presentation 

3.1 Documentation 

Documentation is a set of documents provided on paper, or online, or on digital or analog media, 

such as audio tape or CDs. Examples are user guides, white papers, on-line help, and quick-

reference guides. Paper or hard-copy documentation has become less common. Documentation is 

often distributed via websites, software products, and other on-line applications. 

3.2 .Prepare to create a presentation  

Most organizations need people with skills in designing and producing electronic presentations. 

This function may be part of an administrative role. To work effectively in this area, you need to 

prepare your workspace by understanding safe work practices and by knowing how to identify 

hazards or risks to reduce workplace injury. While a lot of the responsibility for workplace safety 

lies with the employer, employees must also make an active contribution to ensure their workplace 

is safe.  

3.3 Purpose, Audience and Methods of Presentation 

Sharing information is a necessary activity in every workplace. You may have to take part in a staff 

meeting or read a newsletter, and you will probably present information at some time in your 

career. Information can be presented in written, graphic or verbal form. You need to be able to 

communicate in all of these ways.  

During this topic you are going to learn how to prepare and produce an electronic presentation.  

Before you start you need to determine:  

 the purpose of your presentation 

 who your audience is 

 How you will present the material. 

1. Purpose  

What is your electronic presentation about? You may have been asked to present information on a 

specific topic, or you may have decided to present something that you believe will benefit your 

colleagues. Whatever your purpose, make sure you fully understand what your presentation is 

about. You should be aware of the intended message; that is, what you want your audience to 

know.  

2. Audience  

If you take time to get to know your audience, the electronic presentation you develop will be more 

successful. Find out who your audience is.  

https://en.wikipedia.org/wiki/Document
https://en.wikipedia.org/wiki/Online
https://en.wikipedia.org/wiki/Digital_media
https://en.wikipedia.org/wiki/Analog_media
https://en.wikipedia.org/wiki/Audio_tape
https://en.wikipedia.org/wiki/CD


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 Simple questions will help; for example:  

 Is it an internal or an external client?  

 Does the group all come from the same unit/site or do the same job?  

 What will they need to do after they have seen the presentation; for example, will they need to 

practice a task or skill as part of your planning?  

3. Method of presentation  

Whatever presentation method you choose, the way you arrange the information should depend on 

the situation. It is important the method suits both the purpose of your presentation and the 

audience.  

Table 1. Different ways to give a presentation.  

Face to face  Presenting face to face with an audience, such as at a seminar or a staff meeting.  

Specialist 

speaker  

Engaging a specialist speaker/demonstrator for certain aspects of the 

presentation 

Self-running  

 

Choosing a 'self-running' mode, such as a looped video that runs continuously on 

a TV monitor at an exhibition stand 

Self-use Designing a presentation for people to use themselves, such as at a conference 

or a training session, with activities to assess their understanding of the tasks  

Online Setting up the presentation on the internet. 

 

4. Presentation Requirements 

Presentation requirements refer to the many documents and equipment that may be used to 

prepare for and deliver an electronic presentation within your organisation. 

Table 2. Equipment used in presentations  

1 Data projector or 

display monitor  

 

A digital projector can be attached to a computer or tablet to project the 

computer or tablet display onto a larger screen. A data projector is commonly 

used for PowerPoint presentations but it can be used to display almost any 

digital multimedia.  

2 Digital pointer or 

annotation pen  

 

When presenting information you might want to draw attention to an important 

point within a single screen. A hand-held digital pointer can do this. You can 

shine it on the display screen to emphasis a certain area.  

3 Electronic smart 

boards  

Electronic smart boards are an extension to the concept of data projectors 

except that they allow the presenter to interact with the display board. For 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 example, if a computer screen was being displayed onto a smart board, the 

presenter could touch the board to operate the computer functions similar to 

how they would use a mouse.  

4 Sound equipment 

and visual monitors  

 

Audio speakers are often required even in smaller rooms, particularly if your 

presentation has a video clip or uses sound effects. Sometimes in a large venue 

it is necessary to install a background screen or extra screens around the room 

so that all participants can see a visual display clearly (without straining) by 

looking towards a stage area.  

5 Network/Internet 

access  

 

To illustrate certain points you can provide a hyperlink to an interactive 

presentation for participants' use. This may require you to arrange (with your 

information technology department) for special access to data and logon 

privileges, and to be sure you are not breaching any privacy issues regarding 

data that will be displayed.  

6 Speaker 

notes and 

handouts  

 

Having a hard copy of the presenter's notes, internet documents or audience 

handouts can add value to an electronic presentation.  

You may have to write speaker notes or handouts for a presentation that you are 

giving. Speaker notes are thumbnail sketches of each slide to be displayed. 

They help the presenter remember the important points on each slide.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -3 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. What is documentation? 4 points 

2. What is presentation? 4 points 

3. List the presentation equipments? 6 points 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 14 points  Unsatisfactory - below 14 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-4 Identifying organizational requirements  

 

4.1. Organizational requirements 

When defining requirements, many people become confused when they attempt to differentiate 

between business requirements, user requirements, and software requirements. All three types of 

requirements are different and serve different purposes. 

1. Business requirements  

Describe why the organization is undertaking the project. They state some benefits that the 

developing organization or its customers expect to receive from the product. Business 

requirements may be delineated in several documents such as a project charter, business case, or 

in a project vision and scope statements. Business requirements bring the project owner, 

stakeholders and the project team on the same song sheet.  But you can‘t build software from such 

high-level information. In the Enfocus Requirement Suite, ™ we consider the following business 

requirements. 

 Problem Statement 

 Project Vision 

 Project Constraints (Budget, Schedule, and Resources) 

 Project Objectives 

 Project Scope Statements 

 Business Process Analysis 

 Stakeholder Analysis 

The results from the business process analysis and stakeholder analysis activities are also 

considered business requirements. The purpose of the business process analysis is to determine 

how the business process will work. 

2. User requirements  

Referred to as user needs, describe what the user does with the system, such as what activities 

that users must be able to perform.  



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

User requirements are generally documented in a User Requirements Document (URD) using 

narrative text. User requirements are generally signed off by the user and used as the primary 

input for creating system requirements. 

3. System requirements  

The building blocks developers use to build the system. These are the traditional ―shall‖ statements 

that describe what the system ―shall do.‖ System requirements are classified as either functional or 

supplemental requirements.   

 The list below shows various types of supplemental requirements. 

 Accessibility 

 Accuracy 

 Audit, control, and reporting 

 Availability 

 Certification 

 Configuration management 

 Deployment 

 Documentation 

 Efficiency (resource consumption for given load) 

 Effectiveness (resulting performance in relation to effort) 

 Environmental protection 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -2 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. Describe the following terms. (12 points) 

A. Business requirement 

B. User requirement 

C. System requirement 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 12 points  Unsatisfactory - below 12 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-5 Matching document with software functions  

 

5.1. Software Documentation 

Software documentation is written material, images, or video instructions that come with computer 

software. As a rule, software documentation explains how to use a program or a service. 

However, there may be different types of software documentation, depending on the audience it is 

created for.  

 Here are some examples of the software documentation types: 

 Requirements documentation. Typically created in the beginning of a software 

development project. Has the goal to clearly and precisely specify the expectations in 

regards to the software being created. May include functional requirements, limitations, 

hardware or software requirements, compatibility requirements, and so on. 

 Architecture documentation. Defines the high-level architecture of the software system 

being created. May describe the main components of the system, their roles and functions, 

as well as the data and control flow among those components. 

 Technical documentation - Documentation of the software code, algorithms, APIs. Written 

for the technical audience like software developers. 

 End user documentation - Refer to User Guide. 

5.2 Importance of Documentation in Software Development 

For a programmer reliable documentation is always a must. The presence of documentation helps 

keep track of all aspects of an application and it improves on the quality of a software product. Its 

main focuses are development, maintenance and knowledge transfer to other 

developers. Successful documentation will make information easily accessible, provide a 

limited number of user entry points, help new users learn quickly, simplify the product and help cut 

support costs.  

Documentation is usually focused on the following components that make up an application:  

 server environments 

 business rules 

 databases/files 

 troubleshooting 

https://clickhelp.com/software-documentation-glossary/user-guide/


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 application installation  

 Code deployment 

1. Server Environments 

Detailed documentation about an application and its environments is always a must. This 

information will help with setting up new environments for your application and it should present the 

location and function of the systems that run your services. Things that should be specified here 

are the application name/version, server name, IP, code directory, URL to the application, 

operating system, user account information and a point of contact. 

2. Business Rules 

Business rules documentation help new additions to the team adapt faster to the working habits of 

the company. It provides information on how the product works and why. Business rules 

documentation can easily be supported with requirements documents if available.  

3. Database/Files 

Database information is mandatory for porting, reverting, sharing, migrating and so on. It is 

important to know the type of database, the server information, the version but most importantly to 

have a data model diagram. Documentation of the database will make bringing additions to the 

table, modifications to the structure and types. 

4. Troubleshooting 

The troubleshooting documentation helps when running into production issues. Most technical 

issues should have error codes that should help with troubleshooting. In this document there 

should also be included an FAQ section to deal with general or usual problems (such as 

configuration issues). The errors should be documented split by type of error, module where it 

comes from, and level of error (exception, warning, critical, etc...). 

5. Application Installation 

Installation and configuration documents are useful for when developers need to set up new or 

additional application environments. If possible, the steps should be detailed and easy to follow 

and can include screenshots if necessary. Anyone should be able to follow the steps and 

successfully install an application. Having the steps identified will help the installer prevent 

problems because of missing parts of an application.  

6. Code  

The code documentation is the backbone of every application. Code documentation can be split in 

multiple parts. The first one, the most helpful for programmers are the comment blocks. These will 

be found through every file explaining classes, methods, parameters, possible errors. Then comes 

the specific file documentations.  



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

5.3 Benefits of Software Requirements 

 Increase the accuracy of cost and time estimates 

 Simplify the transition of software from development to production 

 Act as a single source of truth regarding what to include in the software solution 

 Improve communication with stakeholders and customers by sharing portions of the 

specifications 

 Reduce costly late stage change 

 Document details for future reference 

 Provide users with a documented list of requirements 

 Reduce development effort and task duplication 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -5 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. what is software documentation.(4 points) 

2. list and describe the types of software documentation requirement(10 points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 14points  Unsatisfactory - below 14 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

  

 

                  https://www.smartsheet.com/software-requirements-specification-101  

                  https://windowsreport.com/software-compare-documents/ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

List of reference and materials 

https://www.smartsheet.com/software-requirements-specification-101
https://windowsreport.com/software-compare-documents/
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Instruction Sheet Learning Guide #10 

 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics: 

 Adjusting page lay out 

 Opening and viewing different toolbars  

 font formatting /font settings 

 alignment and line spacing 

 Opening  and switching 

 formatting features 

 data and formatting tools 

 Highlight and copy text 

 headers and footers 

 file formatting 

 storing  devices

This guide will also assist you to attain the learning outcome stated in the cover page. Specifically, 

Upon completion of this Learning Guide, you will be able to: 

  Adjust page layout to meet information requirements or special needs 

 Open and view different toolbars 

 Change font format /font settings to suit document purpose of the word 

document/spreadsheets/ database entries 

 Change alignment and line spacing,  and modify margins of the document (word / 

spreadsheet/ database/ according to document information requirements  

 Align information in a selected cell as required 

 Open and switch between several word documents / spreadsheets/ database/ 

 Use formatting features and styles to customize basic settings and format cell. 

 Use technical functions, other data and formatting tools, document templates as required 

to finalize documents/or within the spreadsheet 

 Highlight and copy text from another area in the document or from another active 

document; or selected formatting features from another cell in the spreadsheet. 

 Insert headers and footers to incorporate necessary data using formatting features 

 Save document in another file format or spreadsheet as another file type and close 

document and spreadsheet to a storage device  



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Learning Instructions: 

1. Read the specific objectives of this Learning Guide. 

2. Follow the instructions described below 3 to 6. 

3. Read the information written in the information ―Sheet 1 to Sheet 11‖. 

4. Accomplish the ―Self-check 1 to Self-check 11‖ in page -27, 38, 42, 47, 51, 56, 60, 65, 70, 74 

and 77 respectively. 

5. If you earned a satisfactory evaluation from the ―Self-check‖ proceed to ―Operation Sheet 1 to  

Operation Sheet 7 ‖ in page -28, 39, 48, 52, 56 and 71. 

6. Do the ―LAP test‖ in page – 78 (if you are ready). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-1 Adjusting page layout  

 

1.1 page lay out 

Page layout refers to the arrangement of text, images, and other objects on a page. The term was 

initially used in desktop publishing (DTP), but is now commonly used to describe the layout 

of webpages as well. Page layout techniques are used to customize the appearance of magazines, 

newspapers, books, websites, and other types of publications. 

 

Figure 1.  Page Setup in Microsoft Word 

1.2 Page Formatting 

This section will show you how to change your page margins and page size, how to insert headers 

and footers, and how to add page numbers. 

1.2.1 Page Size and Orientation 

By default, the page size is set to Letter, and most people are accustomed to working with this size. 

However, Word provides many different page sizes that correspond to paper sizes, for example 

Executive, Tabloid, A3, and A5. To change the size of your page: 

                            

https://techterms.com/definition/desktoppublishing
https://techterms.com/definition/webpage


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Steps of page size and orientation 

1. Click the Page Layout tab. 

2. Click the Size button from the Page Setup group.  

3. A menu will open, showing the available page sizes. 

4. Choose the size you want from the menu options. 

1.2.2 Headers and Footers 

A header is text that is added to the top margin of every page, for example a document title or 
page number. A footer is text that is added to the bottom margin of every page. Follow these 
steps to add headers or footers to your document: 

                Steps of insert headers and footers 

1. Click the Insert tab. 
2. Click either the Header or Footer button from the Header & Footer group. 
3. Choose the style of header or footer you like from the menu options. 

To remove a header or footer from your document: 

             Steps of remove headers and footers 

1. Click the Insert tab. 
2. Click either the Header or Footer button from the Header & Footer group. 
3. Click Edit Header or Edit Footer. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

                              Figure 2. Page header and page footer 

1.2.3 Page Numbers 

To add page numbers to your document: 

                   Steps of page numbers to your document 

1. Click the Insert tab. 

2. Click the Page Number button from the Header & Footer group. 

3. Choose the location of the page where you want the numbers to appear. 

 

                                    Figure 3. Page numbering 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -1 Written Test 

 

Directions: - Answer all the questions listed below. Use the Answer sheet provided in the next page. 

3. What is page lay out? (4 points) 

4. List the page formatting.(8 points) 

 

 

 

 

 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 12 points  Unsatisfactory - below 12 points  

You can ask your teacher for the copy of the correct answers. 

 
Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -1 Page formatting 

 

Steps of page size and orientation 

1. Click the page layout table 

2. Click the size button from the page setup group 

3. A menu will open, showing the available page size 

4. Choose the size you want from menu options 

Steps of insert headers and footers 

1. Click the insert table 

2. Click the header and footer button from the page setup group 

3. Choose the style of headers and footers you like from the option 

Steps of remove headers and footers 

1. Click the insert table 

2. Click the header and footer button from the page setup group 

3. Click edit header and edit footer  

Steps of page number 

1. Click the insert table 

2. Click the page number button from the header and footer group 

3. Choose the location of the page where you want to the number to a paper 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-2 Toolbars 

 

2.1 Toolbar 

A toolbar is a set of icons or buttons that are part of a software program's interface or an open window. 

When it is part of a program's interface, the toolbar typically sits directly under the menu bar. For 

example, Adobe Photoshop includes a toolbar that allows you to adjust settings for each selected tool. 

If the paintbrush is selected, the toolbar will provide options to change the brush size, opacity, and 

flow.  

 Displaying a Toolbar using the View Menu 

1. On the Menu bar, click View. This displays the View menu. 

2. Then, on the View menu, point to Toolbars item. 

3. Select and click the name of the desired toolbar from the Toolbars sub-menu. The toolbar you 

selected will then appear on screen. 

 

Fig1. Showing or hiding a toolbar using the View menu 

https://techterms.com/definition/menu_bar
http://2.bp.blogspot.com/_d8vcEINJUSQ/TJWjmZfZ27I/AAAAAAAAApw/r1ClJ4Jazto/s1600/Invoke+Toolbar.gif


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Fig 2: Showing or hiding a toolbar using the Customize dialog box 

 

To Display a Desired Toolbar Using a Shortcut 

Simply right-click an empty space on any toolbar, and then click the name of toolbar you want. 

 

Fig 3: Displaying the Customize dialog box via the Toolbar Options button 

 

1.1.1 Standard Toolbar 

You have learned that the Standard toolbar is, by default, docked directly below the Menu bar, and 

that it contains buttons used for performing tasks similar to the commands available in the Menu bar. 

Let's now take a moment to identify the name and purpose/use of each of the buttons on the Standard 

toolbar.  

Table 1. Standard toolbar 

http://1.bp.blogspot.com/_d8vcEINJUSQ/TJWjiltPDEI/AAAAAAAAApg/eVb1oXF5hSk/s1600/TBcustomize+dialog.gif


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

NAME ICON USE 

New 
 

Creates a new blank document based on the  

default or current template. 

Open 
 

Opens a document previously created and saved in  

Word. 

Save 
 

Saves new changes to the current document or  

file, with its filename, location and document format. 

E-mail 
 

Sends the content of the current document as the  

body of an E-mail message. 

Search 
 

Finds files, Web pages and Outlook items based  

on the search criteria you enter. 

Print 
 

Prints the active document or selection. 

Print Preview 
 

Shows how a document or file will look when you  

print it. 

Spelling 
 

Checks spelling in the active document, file or  

item. 

Cut 
 

Removes the selected item from the active  

document and places it in the Clipboard. 

Copy 
 

Copies selected text or object to the Clipboard. 

Paste 
 

Pastes the item you cut or copied into (the  

position of the insertion point) the document from the Clipboard. 

Format Painter 
 

Copies the format from a selected text or object  

and applies it to the text or object you click. 

http://3.bp.blogspot.com/_d8vcEINJUSQ/TCPyc-WqXQI/AAAAAAAAAHQ/tqHC51AOVbY/s1600/New+Blank+Document.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCPy7c2Us2I/AAAAAAAAAHY/Xus4KdJY_OM/s1600/Open.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCPzBcjnUjI/AAAAAAAAAHg/lDAhsfDDTb0/s1600/Save.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCPzKhh4rYI/AAAAAAAAAHo/DZePXcomNbQ/s1600/Email.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCPzTEL3RoI/AAAAAAAAAHw/Reuy10qtqkE/s1600/Search.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCPzbuVVt2I/AAAAAAAAAH4/4_i57xJw6Yg/s1600/Print.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCPzhE6DlcI/AAAAAAAAAIA/fRZZoWH2s_s/s1600/Print+Preview.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCPznZVqSiI/AAAAAAAAAII/B5p25TE3SPI/s1600/Spelling+and+Grammar.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCPztSuHccI/AAAAAAAAAIQ/f-v4odNjsWI/s1600/Cut.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCPzy9q3WxI/AAAAAAAAAIY/peOy_6kf2gw/s1600/Copy.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCPz4l1hNoI/AAAAAAAAAIg/UTjvIQpm4FA/s1600/paste.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCPz-Ch-MlI/AAAAAAAAAIo/grFzJg7v5Mc/s1600/Format+Painter.jpg


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Undo 
 

Reverses the last action or deletes the last  

entry you typed. Click the arrow next to this icon to select and reverse  

multiple actions at a time. 

Redo 
 

Reverses the action of the last Undo command.  

Click the arrow next to this icon to select and reverse multiple Undo  

command actions. 

Insert Hyperlink 
 

Inserts a new hyperlink or edits the selected  

hyperlink. 

Tables and 

Borders  

Displays Tables and Borders toolbar, which  

offers tools for editing/formatting a table and its content. 

Insert Table 
 

Inserts a table in the document. Click and drag  

to specify the number of rows and columns. 

Insert Microsoft 

Excel  

Worksheet 

 

Inserts a new Microsoft Excel worksheet at the  

insertion point. Click and drag to specify the number of rows and columns.  

Use the Excel tools on the toolbar to edit the table. 

Columns 
 

Changes the number of columns in a document or a  

section of a document. 

Drawing 
 

Shows or hides the Drawing toolbar. 

Document Map 
 

Used to turn on or off the Document Map.  

Document Map shows the outline structure of a document so that you can  

quickly navigate through the document and keep track of your location in it. 

Zoom 
 

Used to "zoom in" to get a close-up view of a  

document or "zoom out" to see more of the page at a reduced size. 

http://1.bp.blogspot.com/_d8vcEINJUSQ/TCP0G81QQ7I/AAAAAAAAAIw/G3gTLNeaE0U/s1600/Undo.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCP0MgciqAI/AAAAAAAAAI4/zt0w2CYvjaM/s1600/redo_COLORED.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCP0TvjgpFI/AAAAAAAAAJA/oITeMKqiric/s1600/Insert+Hyperlink.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCP0ZG4YAEI/AAAAAAAAAJI/6CiJxwL_oxA/s1600/Tables_and_BordersCOLORED.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCP0jb-BWrI/AAAAAAAAAJQ/vnwIoV2ru_I/s1600/InsertTable_COLORED.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCP0pa6vu7I/AAAAAAAAAJY/FaPGoRiCh_A/s1600/Insert_Microsoft_Excel_Worksheet.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCP00WOwKII/AAAAAAAAAJg/5CuYATcRSKo/s1600/Collumns.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCP1AptbwxI/AAAAAAAAAJo/kM3DM1jBstI/s1600/Drawing.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCP1GTxzoXI/AAAAAAAAAJw/9D6XzBM3uW4/s1600/DocumentMap.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCP1NHEojTI/AAAAAAAAAJ4/gRYmdpSgQm8/s1600/Zoom.jpg


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Show/Hide 
 

Shows or hides non-printing characters, such as  

tab characters, paragraph marks and hidden text. 

Office Assistant  

(Microsoft Office 

Help) 

 

Opens Help or invokes the Office Assistant to  

provide help topics and tips to help you accomplish your task. 

 

1.1.2 Formatting Toolbar 

The Formatting toolbar offers shortcut buttons to help format a document quickly. From the Formatting 

toolbar, you can quickly apply formatting attributes such as Font; Font Color; Alignment; Line Spacing; 

Bullets and Numbering, etc, document text, to save time. 

The following table provides a list of Formatting toolbar buttons and a brief description of each.  

Table 2. Formatting toolbar 

NAME ICON USE 

Style 
 

Opens a Style drop-down list from which you can  

select one. 

Font 
 

Changes the font of the selected text or number.  

Click the drop-down arrow beside the box and select a font from the 

list. 

Font Size 
 

Changes the size of the selected text or number.  

Enter a size value in the box, or select an appropriate size from the  

drop-down list. 

Bold 
 

Applies or removes bold formatting to or from a  

selected text or number. 

Italic 
 

Makes selected text or number italic, but  

http://3.bp.blogspot.com/_d8vcEINJUSQ/TCP1WIm1vWI/AAAAAAAAAKA/cLQ3nIc497A/s1600/Show_Hide_Pa.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCP1fQcJIQI/AAAAAAAAAKI/dgN0SwfV7yk/s1600/MicrosoftWordHelp.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCZmTS6HK3I/AAAAAAAAALA/72Dogbpk7_c/s1600/Style.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZoI7U46PI/AAAAAAAAALI/XJNGtsJvpN8/s1600/FontBox.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCZorJX4d4I/AAAAAAAAALQ/JbyVxseJjKQ/s1600/Font+Size.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZo6ANnAHI/AAAAAAAAALY/W4Fw-Jnmn2Q/s1600/Bold.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZpYGcfKCI/AAAAAAAAALo/aLKrrY23VO0/s1600/Italic.jpg


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

removes italic from selected text or number if it's already italic. 

Underline 
 

Underlines (rules a line)  or removes  

underline formatting from selected text or number. 

Align Left 
 

Aligns the selected text, number or inline  

object to the left with a jagged edge. 

Center 
 

Aligns selected text, numbers or inline objects  

to the center. 

Align Right 
 

Aligns the selected text, number or inline  

objects to the right, with a jagged edge. 

Justify 
 

Aligns the selected paragraphs to both the left  

and right margins or indents. 

Numbering 
 

Adds numbers to or removes numbers numbers from  

selected paragraphs. 

Bullets 
 

Adds bullets to or removes bullets from the  

selected paragraphs. 

Decrease 

Indent  

Indents the selected paragraph to the previous  

tab stop or indents the content of the selected item to the left by one  

character width of the standard font. 

Increase 

Indent  

Indents the selected paragraph to the next tab  

stop or indents the content of the selected item to the right by one  

character width of the standard font. 

Outside 

Border  

Adds or removes a border around the selected  

text, paragraphs, cells, pictures or other objects. 

http://3.bp.blogspot.com/_d8vcEINJUSQ/TCZpyd75wzI/AAAAAAAAALw/DzJYN-07csI/s1600/Bullets.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCZqRSTpC2I/AAAAAAAAAL4/hWKxZu2yI3U/s1600/Align+Left.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCZqY3s20AI/AAAAAAAAAMA/X2TGuv8yg7o/s1600/Center.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZqggxhSTI/AAAAAAAAAMI/C3Ftjnw97gQ/s1600/Align+Right.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZqpHoPWJI/AAAAAAAAAMQ/OLcBFTgiVb8/s1600/Justify.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCZqwwq5BeI/AAAAAAAAAMY/HgUySlDCDaM/s1600/Numbering2.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZsitXVOQI/AAAAAAAAAMg/-dV1rcTOI0s/s1600/Numbering.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZuEnRZKyI/AAAAAAAAAMw/UsBL8lFbFp4/s1600/Decrease+Indents.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZtuHDTTDI/AAAAAAAAAMo/pkjbyIU1AgY/s1600/Increase+Indents.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCZuNQVXiJI/AAAAAAAAAM4/UDacTuJ6SMA/s1600/Outside+Border.jpg


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Highlight 
 

Marks text so that it is highlighted and stands  

out from the surrounding text. 

Font Color 
 

Formats the selected text with the color you  

click 

 

1.1.3 Drawing Toolbar 

The Drawing toolbar is located at the bottom of the window, between the Horizontal Scroll bar and the 

Status bar. Like every other toolbar, this also contains smart icons representing shortcuts to Main 

menu commands in Word. 

 Table 3. Shows a list of tools offered on the Drawing toolbar, and their functions: 

NAME ICON USE 

Draw 
 

Offers a number of options for defining the  

relative positions, arrangements, rotation, etc, of drawings in a 

document.  

It also offers tools for changing the shape of AutoShapes. 

Select Objects 
 

Changes the pointer to a selection arrow so you  

can click to select objects in the active window. 

AutoShapes 
 

Offers a group of ready-made shapes that include  

basic shapes, such as rectangles and circles, including a variety of 

lines  

and connectors, block arrows, flowchart symbols, stars and banners, 

and  

callouts. 

Line 
 

Allows you to draw a straight line where you  

click or drag in the active window. 

http://2.bp.blogspot.com/_d8vcEINJUSQ/TCZuVVrQmnI/AAAAAAAAANA/MtPUsyagwbQ/s1600/Highlight.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCZukuT1aoI/AAAAAAAAANI/kiTWZIZm8vw/s1600/Font+Color.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaAdxnggWI/AAAAAAAAANQ/4Xdrrz9CisY/s1600/Draw_COLORED.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCaAvXv9A7I/AAAAAAAAANY/Dx9wroKHlxQ/s1600/Select+Objects_COLORED.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaB7-HsitI/AAAAAAAAANg/aImEYBt5cGQ/s1600/AutoShapes_COLORED.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCaHcvkLhpI/AAAAAAAAAOI/NCpzTWTNQWI/s1600/Line_COLORED.jpg


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Arrow 
 

Draws or inserts a line with an arrow head where  

you click or drag in the active window. 

Rectangle 
 

Draws a rectangle where you click and drag on  

the active window. You can also draw a square using this tool by 

holding  

SHIFT while you drag. 

Oval 
 

Draws an oval where you click and drag in the  

active document. To draw a (perfect) circle, hold down SHIFT while 

you drag. 

Text Box 
 

Draws a text box with horizontal direction where  

you click and drag in the active document. 

Insert WordArt 
 

Creates decorative text by inserting a Microsoft  

Office drawing objects. 

Insert Diagram 
 

Creates an organizational chart or a circle,  

radial, pyramid, or Venn or target diagram in your document. 

Clip Art 
 

Opens the Clip Gallery where you can select the  

clip art image you want to insert in your document or update your 

clip art  

collection. 

Insert Picture 
 

Inserts an existing picture in your  active  

document at the insertion point. 

Fill Color 
 

Adds, modifies, or removes the fill color or  

effects from the selected object. 

Line Color 
 

Adds, modifies, or removes the line color from  

the selected object. 

http://3.bp.blogspot.com/_d8vcEINJUSQ/TCaHH0G3qzI/AAAAAAAAAN4/pfgKOxKbAkU/s1600/Arrow_COLORED.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCaHRiCUXwI/AAAAAAAAAOA/p2qLd9FMbUQ/s1600/Rectangle_COLORED.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCaKGISF4MI/AAAAAAAAAOY/UDcyWGjsz54/s1600/Oval_COLORED.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaKUhEpC8I/AAAAAAAAAOg/f8xxa--H70I/s1600/Text+Box_COLORED.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCaKiio77gI/AAAAAAAAAOo/TAJs69_Gjcw/s1600/Insert+WordArt_COLORED.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCaK2RKfC4I/AAAAAAAAAOw/P4zT91N-n-g/s1600/Insert+Diagram+or+Organizational+Chart_COLORED.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCaLMpUs7rI/AAAAAAAAAO4/jsn-9Seq2-g/s1600/Insert+ClipArt.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaLghlJS9I/AAAAAAAAAPA/LeW0O0qJsYg/s1600/Insert+Picture.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCaL3gs_9EI/AAAAAAAAAPI/wjNU23VvBkY/s1600/Fill+Color.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaMIDbv__I/AAAAAAAAAPQ/DXkrWClLQLY/s1600/Line+Color.jpg


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Font Color 
 

Allows you to add, modify, or remove the text  

color of the selected text. 

Line Style 
 

Used to select a thickness for the selected  

line. 

Dash Style 
 

Allows you to control the appearance of the  

selected line. 

Arrow Style 
 

Allows you to select the style of arrowhead. 

Shadow Style 
 

Allows you to select the shadow appearance of  

the selected drawing object. 

3-D Style 
 

Allows you to add depth to drawing objects such  

as lines, AutoShapes, and freeform objects. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaMWpT5H6I/AAAAAAAAAPY/PQc4VY6f3vQ/s1600/Font+Color.jpg
http://4.bp.blogspot.com/_d8vcEINJUSQ/TCaMf-FgVkI/AAAAAAAAAPg/ImJEIJoIyPw/s1600/Line+Style.jpg
http://1.bp.blogspot.com/_d8vcEINJUSQ/TCaMuY_P2qI/AAAAAAAAAPo/cPU3-NBP75M/s1600/Dash+Style.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCaM5n9LGTI/AAAAAAAAAPw/Eaxi_9JHJqU/s1600/Arrow+Style.jpg
http://2.bp.blogspot.com/_d8vcEINJUSQ/TCaNELptoJI/AAAAAAAAAP4/H0DZGrMiu6M/s1600/Shadow+Style.jpg
http://3.bp.blogspot.com/_d8vcEINJUSQ/TCaRVJGejDI/AAAAAAAAAQA/MOq4zrcH1Y8/s1600/3-D+Style.jpg


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -2 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. What is toolbar? (4 points) 

2. List and describe at least 5 drawing toolbar? (8 points) 

3. List and describe at least 5 formatting toolbar (8 points) 

 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 20 points  Unsatisfactory - below 20 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -2 Displaying a Toolbar using the View Menu 

 

Steps to displaying a Toolbar using the View Menu 

1. On the Menu bar, click View. This displays the View menu. 

2. Then, on the View menu, point to Toolbars item. 

3. Select and click the name of the desired toolbar from the Toolbars sub-menu. The toolbar you 

selected will then appear on screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-3 font format /font settings 

 

3.1 Font | Text Formatting in MS-Word 

 Font | Text Formatting means to make the selected text Bold, Italic, Underline, and 

changing the Font Style, Size, Color  and some of these or all of these for changing the 

look of the title, subtitle, heading, subheading, and other text styles in a word document.   

The Font group includes various commands such as a Font, Font Size, Grow Font, Shrink 

Font, Clear Formatting, Bold, Italic, Underline, Strike Through, Subscript, Superscript, 

Change Case, Text highlight Color and Font Color.  

 

 

Figure 1. Font | Text Formatting in Microsoft Word 

 

http://www.linfo.org/command.html


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

3.2 Changing the Font 

The most common way to format text is to change the font. The font defines the uniform style and 

appearance of letters such as Arial, Arial Black, Courier, Old English, or Stencil.  

To change the font, follow these steps: 

1. Click the Home tab and then select the text you want to change. 

2. Click the Font list box. A list of available fonts on your computer appears. 

3. Move the mouse pointer over each font. Word temporarily changes your selected text so you 

can see how the currently highlighted font will look. 

4. Click the font you want to use. Word changes your text to appear in your chosen font. 

3.3 Changing the Font Size 

The font changes the appearance of text, but the font size defines how big (or small) the text may look.  

To change the font size, you have two choices: 

 Select a numeric size from the Font Size list box. 

 Choose the Grow Font/Shrink Font commands. 

To change the font size, follow these steps: 

1. Click the Home tab and then select the text you want to change. 

2. Choose one of the following: 

o Click the Font Size list box and then click a number, such as 12 or 16. 

o Click the Grow Font or Shrink Font icon.  

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -3 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. What formatting? (4 points) 

2. List at least 8 font groups? (16 points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 20 points  Unsatisfactory - below 20 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -3 Changing  the font 

Steps to change the font 

1. Click the Home tab and then select the text you want to change. 

2. Click the Font list box. A list of available fonts on your computer appears. 

3. Move the mouse pointer over each font. Word temporarily changes your selected text so you 

can see how the currently highlighted font will look. 

4. Click the font you want to use. Word changes your text to appear in your chosen font. 

Steps the changing the Font Size 

1. Click the Home tab and then select the text you want to change. 

2. Choose one of the following: 

o Click the Font Size list box and then click a number, such as 12 or 16. 

o Click the Grow Font or Shrink Font icon.  

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-4 alignment and line spacing 

 

4.1 Alignment  

Alignment refers to where and how the text lines up. Default settings in Microsoft Word will leftalign 

your text, but there are many other ways to format a document‘s alignment. This tutorial outlines two 

ways to modify alignment: using keyboard commands and using the Ruler bar. 

Probably the quickest method to adjust alignment is to use keyboard shortcuts:  

 Ctrl + L = Left alignment     

 Ctrl + E = Center alignment  

 Ctrl + R = Right alignment  

 Ctrl + J = Justified alignment  

 

Figure 1. Alignment 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

4.2 Line spacing 

Document text can be formatted to show a number of line-spacing options. The most common spacing 

options are single spaced and double spaced. 

 

Line spacing is measured in lines or points. When line spacing is measured in points, it is referred to 

as leading (rhymes with wedding). When you reduce the leading, you automatically bring the lines of 

text closer together, sometimes making it difficult to read. Increasing the leading will space the lines 

out, allowing for improved readability. For example, a 10-point font usually uses 12-point leading. This 

is the default and should be used in general. 

To format line spacing: 

 Select the text you want to format. 

 Choose Reveal Formatting on the task pane and click any of the blue links under the 

paragraph heading. 

OR 

 Click Format on the menu bar. 

 Select Paragraph. The Paragraph dialog box appears. 

 Click the Indents and Spacing tab. 

 In the line spacing drop-down menu, you can select single, 1.5, or double spacing. The 

default is single spacing. 

 Click OK. 

 Select an option from the drop-down menu. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Figure 2 line spacing option 

 

 

Figure 3.  Single and double line spacing  

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -4 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

3. What Alignment? (5points) 

4. What is line spacing? (5 points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 10 points  Unsatisfactory - below 10 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -4 Line spacing 

Steps of line spacing 

1. Click Format on the menu bar. 

2. Select Paragraph. The Paragraph dialog box appears. 

3. Click the Indents and Spacing tab. 

4. In the line spacing drop-down menu, you can select single, 1.5, or double spacing. The 

default is single spacing. 

5. Click OK. 

6. Select an option from the drop-down menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-5 Open and switch 

5.1 Open Microsoft Word 

Microsoft Word is a word-processing application that can be part of the Microsoft Office suite. The 

program can be used to write letters and different types of documents that can include graphics and 

pictures.  This guide explains how to open Microsoft Word and start a new document for Word Office 

365 and Windows 10. 

It can be found in the ‗Start‘ menu under ‗Accessories‘. Click on 'All programs' and then scroll to 

'Accessories' folder 

Follow these step-by-step instructions to start a document in Microsoft Word 

Step 1: From the desktop or from your ‗Start‘  menu, open Microsoft Word. 

 

Figure 1. Start 

Step 2: Microsoft Word will open up and present you with an option to select a document template, or 
a blank document. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Figure 2. Open MS word 

Step 3: If you don't want to use any of the templates on display, click on the blank document. 

 

Figure 3. Blank document 

 

Step 4: A new blank document will open up ready for you to start typing 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -5 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. What is micro soft word? (5points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 5 points  Unsatisfactory - below 5 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -5 Opening MS word 

 

 Step-by-steps instructions to start a document in Microsoft Word 

Step 1: From the desktop or from your ‗Start‘ menu, open Microsoft Word. 

Step 2: Microsoft Word will open up and present you with an option to select a document 

template, or a blank document. 

Step 3: If you don't want to use any of the templates on display, click on the blank document 

Step 4: A new blank document will open up ready for you to start typing 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-6 formatting features 

6.1 Formatting 

Formatting is the fine art of making your documents effective and attractive. Good formatting 

distinguishes different parts of your text and helps your readers take in your message. You can apply 

formatting to just about every element of your document, from a single character to entire paragraphs. 

Body text needs to be readable and easy on the eyes. Headings should be big and bold, and they 

should also be consistent throughout your document. Important words need to resonate with 

emphasis. Quotes and references should be set off from the other text. 

6.2 Formatting Basics 

Word deals with formatting on three levels encompassing small and specific on up to big and broad—

through characters, paragraphs, and sections. You apply different types of formatting to each of these 

parts. Character formatting includes selecting a font, a font size, bold or italics, and so on.  

6.3 Important of formatting 

 For one thing, it improves consistency and readability. Using headers and paragraphs to organize 

information makes the reader‘s job easier, which can be a great time-saver for busy professionals. 

Whether you‘re writing a proposal, a report, or a simple letter, structure helps to communicate your 

message clearly. 

6.4 Formatting Tips for Word documents 

1. Paragraphs 

A fundamental element of information organisation, a paragraph is a collection of (usually three to five) 

related sentences describing a single thought or concept. Use paragraphs to break up long, complex 

texts into smaller and easily digestible chunks. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Figure 1. Paragraph 

2. Lists 

Like paragraphs, lists are an excellent way to present information in an organised, easy to read  

Word will apply the default list styles. Format lists by clicking the arrows next to each button to view 

the Bullet, Numbering, and List libraries. 

 

Figure 2. Lists 

3. Headers and footers 

Give your document that professional edge by adding headers and footers. These can be used to 

display the document author‘s name, the date of publication, and even your company logo. When you 

create a header or footer, Word automatically updates the content on every page of your document. 

A third button in the Header & Footer section – Page Number – allows you to insert page numbers. 

https://www.documentswithprecision.com/wp-content/uploads/2016/01/Screenshot-5.png
https://www.documentswithprecision.com/wp-content/uploads/2016/01/Screenshot-2.png


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Figure 3 headers and footers 

4. Fonts 

Let‘s face it: fancy fonts aren‘t very professional. It‘s also important that business documents, often 

long and information-heavy, are easy to read. Word offers a number of easily legible fonts such as 

Calibri (the default), Arial, and Times New Roman. 

 

Figure 4. Fonts 

5. Graphics 

Add a bit of visual appeal to your document with graphic elements such as images, Smart Art, and 

screenshots. Word also offers a variety of options in its Shapes library, which can be used to make 

important information stand out. 

Images, shapes, Smart Art, and screenshots can be added from the Illustrations section of the ribbon‘s 

Insert tab. 

 

Figure 5. Graphics 

https://www.documentswithprecision.com/wp-content/uploads/2016/01/Screenshot-4.png
https://www.documentswithprecision.com/wp-content/uploads/2016/01/Screenshot-1.png
https://www.documentswithprecision.com/wp-content/uploads/2016/01/Screenshot-3.png


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -6 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. What is formatting? (3points) 

2. List the five tips of formatting(10points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 13 points  Unsatisfactory - below 13 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet -7 data and formatting tools 

 

7.1 Data  

Computer data is information processed or stored by a computer. This information may be in the form 

of text documents, images, audio clips, software programs, or other types of data. Computer data may 

be processed by the computer's CPU and is stored in files and folders on the computer's hard disk. 

At its most rudimentary level, computer data is a bunch of ones and zeros, known as binary data. 

Because all computer data is in binary format, it can be created, processed, saved, and 

stored digitally. This allows data to be transferred from one computer to another using a network 

connection or various media devices. It also does not deteriorate over time or lose quality after being 

used multiple times. 

 

7.2 Formatting Tools 

The Formatting tab in the TXLF Editor includes formatting tools that can be used to edit the target 

content format. 

 The formatting tools are categorized in three sections: 

1. Format 

Table 1. The Format options are available only for MS Office source files. The formatting options are: 

Button Keyboard Shortcut Description 

 

Ctrl+B Format the selected text as bold. 

 

Ctrl+I Format the selected text as italic. 

 

Ctrl+U Format the selected text as underlined. 

https://techterms.com/definition/cpu
https://techterms.com/definition/file
https://techterms.com/definition/folder
https://techterms.com/definition/harddisk
https://techterms.com/definition/binary
https://techterms.com/definition/digital


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Button Keyboard Shortcut Description 

 

Ctrl+= Format the selected text as subscript. 

 

Ctrl+Shift+= Format the selected text as superscript. 

 

No shortcut Format the selected text to display as strikethrough (deleted), 

without actually deleting the text. 

 

2. tags 

Table 2. The tag formatting options are: 

Button Keyboard Shortcut Description 

 

No shortcut Display actual formatting associated with tags for 

the active segment (when supported.) 

 

No shortcut Display the content of the formatting tags for the 

active segment. 

3. Options 

Table 3. The other formatting options are: 

Button Keyboard Shortcut Description 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Button Keyboard Shortcut Description 

 

Ctrl+Shift+Space Insert a non-breaking space at the cursor location. 

 

No shortcut Insert a marker to indicate left-to-right reading direction. 

 

No shortcut Insert a marker to indicate right-to-left reading direction. 

 

Ctrl+D Attach and detach the Formatting toolbar. When attached, the 

toolbar is displayed as a tab. When detached, the toolbar is 

displayed as a minimized toolbar that can be moved to any area of 

the TXLF Editor. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -7 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. Define data? (3points) 

2. List and describe the tree categories of formatting tools (9points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 12 points  Unsatisfactory - below 12 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet -8 Highlight and copy text 

8.1. Highlighting 

About the most valuable lessons you can ever learn about your computer is highlighting and 

copy/cut/paste. If there's nothing else that you take with you, that's the most important thing I could 

ever teach you. It'll literally save days of your life from repetitive work, and retyping existing 

information.  

Here's two general highlighting technique s:  Object, and Text 

Object Highlighting (Files, items in a list-box, and other non-text Objects) 

                                                        

                                

Item 1

Item 2

Item 3

Item 4

Item 5

Item 6

 

Highlight a Group of 

Items in a row 

 Using the list below, click on "Item 

2" in the list. 

 Hold down the <Shift> key 

 Click on the "Item 4". 

 Release the <Shift> key 

Alternate: 

 With your Mouse, you can click-and-

drag on "Item 2" to "Item 4" and 

then release. 

Highlight two, or more 

things not in a row 

 Using the list below, click on the 

second item in the list. 

 Hold down the <Ctrl> key 

 Click on the fourth item. 

 Release the <Ctrl> key 

Highlight a group, 

then highlight one 

more thing 

 Using the list below, click on "Item 

2" in the list. 

 Hold down the <Shift> key 

 Click on "Item 4". 

https://pcrei.com/computer/cutcopypaste.html#Object
https://pcrei.com/computer/cutcopypaste.html#Text


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 Release <Shift> key 

 Hold down the <Ctrl> key 

 Click on "Item 6" 

 Release the <Ctrl> key 

Note: This is just using the first two 

methods together 

 

Text Highlighting 

   

 

Select this paragraph of 

text and paste it into a 

notepad or Word 

Processor window. 

 

Then practice navigating 

and selecting things to 

see how to make yourself 

more efficient. 

 

This is going to be one of 

the hardest things to 

remember to do, and it 

will take time and 

diligence to make a 

permanent change. But if 

Mouse 

Actions (All actions with Left Mouse button):   

Single-click  = Set Cursor Position  

Single-click-and-drag  = Highlight from beginning position to place where 

button is released.  

Double-click  = Highlight word  

Double-click-and-drag  = Highlight word, and all other words between 

beginning point, and where button is released.  

Triple-click (usually works in word processors and sometimes other 

locations)  = Select Paragraph 

Main Key 

<Shift> Key Definition:  While held down, anything the Cursor passes 

over will be highlighted.  

Used with:  Anything 

Alternate Keys  (Can be used for non-highlighting purposes. Use any 

combination below with <Shift> to highlight all text between current 

cursor position and destination of cursor) 

<Ctrl> Key Definition:  Jumps to the beginning of previous/next word 

when used in combination with Left/Right Arrow keys.  



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

you change your habit, it 

will save days, weeks or 

maybe even months of 

your life and make you a 

faster and more efficient 

computer user. 

Combinations (<Ctrl>+) :   

<Home> =Move to top of document.  

<End> =Move to top of document.  

Additional Notes: Microsoft Word, and Corel WordPerfect 

have:  

<Ctrl>+<Down Arrow> =Cursor moves to beginning of 

previous paragraph.  

<Ctrl>+<Up Arrow> =Cursor moves to beginning of next 

paragraph. 

<Home> Key Definition:  Jumps to the beginning of the line of text.  

Combinations: (<Home>+)  

<Ctrl> =Moves to the beginning of the text document. 

<End> Key Definition:  Jumps to the end of the line of text.  

Combinations: (<End>+)  

<Ctrl> =Moves to the end of the text document. 

<Page Up> 

Key 

Definition:  Moves cursor up one page of (visible) text. 

<Page 

Down> Key 

Definition:  Moves cursor down one page of (visible) text. 

  

 

Clipboard - Using Cut, Copy, and Paste  

Rule:  To use Cut, Copy and Paste you must first highlight the item you want to Cut or Copy. See 

above for highlighting tips.  

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

                           Table short cut copy past  

Action HotKey 

Cut <Ctrl>+<x> 

Copy 
<Ctrl>+<c> or  

<Ctrl>+<Insert> 

Paste 
<Ctrl>+<v> or  

<Shift>+<Insert> 

 

8.2. Copy and paste text in a document  

Cutting, copying, and pasting are basic file-management commands. You can cut, copy, and paste 

files and folders (and other things) in Windows Vista.  

 Follow these steps to Copy and paste text in a document 

1. Select the item to cut or copy: a few words, a file, a Web address, or any other item. 

2. Right-click your selection and choose Cut or Copy from the menu that appears, depending on 

your needs. 

Keyboard shortcut: Hold down Ctrl and press X to cut or C to copy. 

3. Right-click the item’s destination and choose Paste. 

You can right-click inside a document, folder, or nearly any other place. 

Keyboard shortcut: Hold down Ctrl and press V to paste. 

   

Figure 1. Copy and paste                                     short cut copy form keyboard 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -8 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. Define highlight.  (5points) 

2. what are the two highlight techniques (5points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 10 points  Unsatisfactory - below 10 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -8 Cut, Copy and paste in a documents 

 

Steps to Copy and paste text in a document 

1. Select the item to cut or copy: a few words, a file, a Web address, or any other item. 

2. Right-click your selection and choose Cut or Copy from the menu that appears, depending on 

your needs. Keyboard shortcut: Hold down Ctrl and press X to cut or C to copy. 

3. Right-click the item‘s destination and choose Paste. 

4. You can right-click inside a document, folder, or nearly any other place. 

Keyboard shortcut: Hold down Ctrl and press V to paste.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet -9 headers and footers 

 

9.1 Headers and footers  

The header is a section of the document that appears in the top margin, while the footer is a section 

of the document that appears in the bottom margin. Headers and footers generally contain additional 

information such as page numbers, dates, an author’s name, and footnotes, which can help keep 

longer documents organized and make them easier to read. Text entered in the header or footer will 

appear on each page of the document. 

9.1.1 Create a header or footer 

In our example, we want to display the author's name at the top of each page, so we'll place it in the 

header. 

1. Double-click anywhere on the top or bottom margin of your document. In our example, 

we'll double-click the top margin. 

 

Figure 1. Top or bottom margin 

2. The header or footer will open, and a Design tab will appear on the right side of 

the Ribbon. The insertion point will appear in the header or footer. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Figure 2. Open header or footer 

 

3. Type the desired information into the header or footer. In our example, we'll type the 

author's name and the date. 

 

Figure 3. Desired information into the header or footer 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

4. When you're finished, click Close Header and Footer. Alternatively, you can press 

the Esc key. 

 

Table 4. Close header and footer 

5. The header or footer text will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -9 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. Define headers and footers.  (6 points) 

2. What are the two highlight techniques (5 points?) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 6points  Unsatisfactory - below 6 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -9 Creating header and footers 

 

Steps to create headers and footers 

1. Double-click anywhere on the top or bottom margin of your document. In our example, 

we'll double-click the top margin. 

2. The header or footer will open, and a Design tab will appear on the right side of 

the Ribbon. The insertion point will appear in the header or footer. 

3. Type the desired information into the header or footer. In our example, we'll type the 

author's name and the date. 

4. When you're finished, click Close Header and Footer. Alternatively, you can press 

the Esc key. 

3. The header or footer text will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet -10 File format 

 

10.1 File format 

A file format is a standard way that information is encoded for storage in a computer file. It specifies 

how bits are used to encode information in a digital storage medium. File formats may be 

either proprietary or free and may be either unpublished or open. 

Some file formats are designed for very particular types of data: PNG files, for example, 

store bitmapped images using lossless data compression. Other file formats, however, are designed 

for storage of several different types of data: 

10.1.1 Common file formats 

 

Figure 1. File formats 

 

 

 

https://en.wikipedia.org/wiki/Computer_standard
https://en.wikipedia.org/wiki/Computer_file
https://en.wikipedia.org/wiki/Bit
https://en.wikipedia.org/wiki/Proprietary_format
https://en.wikipedia.org/wiki/Open_format
https://en.wikipedia.org/wiki/Open_format
https://en.wikipedia.org/wiki/Portable_Network_Graphics
https://en.wikipedia.org/wiki/Raster_graphics
https://en.wikipedia.org/wiki/Graphics_file_format
https://en.wikipedia.org/wiki/Lossless_data_compression


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Table 1. List of common file formats  

File type File extension 

Text .asc .doc .docx .rtf .msg .txt .wpd .wps 

Image .bmp .eps .gif .jpg .pict .png .psd .tif 

Sound .aac .au .mid .mp3 .ra .snd .wma .wav 

Video .avi .mp4 .mpg .mov .wmv 

Program .bat .com .exe 

Compressed .arc .arj .gz .hqx .rar .sit .tar .z .zip 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.computerhope.com/jargon/t/textfile.htm
https://www.computerhope.com/jargon/d/doc.htm
https://www.computerhope.com/jargon/d/docx.htm
https://www.computerhope.com/jargon/r/rtf.htm
https://www.computerhope.com/jargon/m/msg.htm
https://www.computerhope.com/jargon/t/txt.htm
https://www.computerhope.com/jargon/w/wps.htm
https://www.computerhope.com/jargon/i/image.htm
https://www.computerhope.com/jargon/b/bmp.htm
https://www.computerhope.com/jargon/g/gif.htm
https://www.computerhope.com/jargon/j/jpeg.htm
https://www.computerhope.com/jargon/p/png.htm
https://www.computerhope.com/jargon/t/tiff.htm
https://www.computerhope.com/jargon/s/sound.htm
https://www.computerhope.com/jargon/m/midi.htm
https://www.computerhope.com/jargon/m/mp3.htm
https://www.computerhope.com/jargon/w/wma.htm
https://www.computerhope.com/jargon/w/wav.htm
https://www.computerhope.com/jargon/v/video.htm
https://www.computerhope.com/jargon/a/avi.htm
https://www.computerhope.com/jargon/m/mpeg4.htm
https://www.computerhope.com/jargon/m/mpeg.htm
https://www.computerhope.com/jargon/m/mov.htm
https://www.computerhope.com/jargon/w/wmv.htm
https://www.computerhope.com/jargon/p/program.htm
https://www.computerhope.com/jargon/b/bat.htm
https://www.computerhope.com/jargon/c/com.htm
https://www.computerhope.com/jargon/e/execfile.htm
https://www.computerhope.com/jargon/c/compfile.htm
https://www.computerhope.com/jargon/g/gzip.htm
https://www.computerhope.com/jargon/r/rar.htm
https://www.computerhope.com/unix/utar.htm
https://www.computerhope.com/jargon/z/zip.htm


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -10 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. What is file format? (5points) 

2. list the common typs of file format (10points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 15 points  Unsatisfactory - below 15 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet -11 storage device 

 

 11.1 Storage device 

A storage device is a term used for anything in which items or information may be stored. It‘s a very 

broad term as well. In your home a storage device can be a closet or a pantry/cabinet; if you have a 

garage, that‘s a storage device. In your car, your trunk and glove compartments are storage devices. 

In a computer, your hard drive is a storage device used to store information.  

11.1.1 Types of Storage Devices  

1. Primary storage 

 Which is also referred to as internal memory, is accessed by a computer's central processing unit 

(CPU). It is usually the fastest and most expensive type of memory in the computer. Primary storage 

uses random-access memory (RAM), cache memory.  

2. Secondary storage  

On a computer is provided by non-volatile devices such as hard disk drives. Even though a hard drive 

may be housed within a desktop or laptop, it's not considered to be primary because it's not accessed 

directly by the CPU. Data stored on hard disk drives and most other types of secondary storage 

devices is organized according to a file system. This type of storage is slower than primary storage, 

but it's also cheaper. 

                                           Common types of storage devices 

       

   1. Hard Disk Drive (HDD)                             2. Solid State Drive (SSD)                 3. Random Access Memory (RAM) 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

  

           1. CD, DVD and Blu-Ray Discs            2. DVD-RAM                          ROM 

USB Flash Memory 

                                            Figure 1. Storage devices 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -11 Written Test 

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. Define storage devices.  (6points) 

           2. list the common types of storage devices. (5points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 6points  Unsatisfactory - below 6 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________   Time finished:  ________________ 

                   Instruction: Given necessary templates, tools and materials you are required to perform the following 

tasks within 2 hours. 

Task 1. Page format 

Task 2. Display toolbar using the view menu  

Task 3. Change the font  

Task 4. Line spacing  

Task 5. Open MS word 

Task 6. Cut copy and paste in document 

Task 7. Create header and footer 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LAP Test  Practical Demonstration 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

  

 

https://wordribbon.tips.net/C0716_Page_Layout.html 

https://www.dummies.com/computers/operating-systems/windows-xp-vista/cut-copy-and-paste-selected-

files-and-folders/ 

https://courses.lumenlearning.com/wm-compapp/chapter/headers-and-footers/ 

https://whatis.techtarget.com/definition/file-format 

 

 

 

 

 

 

 

 

 

 

 

 

List of reference and materials 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Horticultural Crops Production 

 

                      Level-II 

 

Learning Guide-11 

Unit of Competence: Operate application software 

packages 

Module Title: Operating application software packages 

 

LG Code: AGR HCP1 M03 LO3-LG-11 

TTLM Code: AGR HCP2 TTLM 0120v1 

 

 

 

LO 3:  Create Tables and Add Images to 

Word Documents 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Instruction sheet Learning Guide #11 

 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics –  

 Inserting standard table into document 

  Changing cells (insert and delete columns and rows) 

 Inserting images 

 Creating  folders  

  Printing documents 

This guide will also assist you to attain the learning outcome stated in the cover page. Specifically, 

upon completion of this Learning Guide, you will be able to – 

  Insert standard table into document 

 Change cells (insert and delete columns and rows) to meet information requirements 

 Insert appropriate images into document and customise as necessary 

 Position and resize images to meet document formatting needs 

 Ensure the naming and storing/ saving of documents in appropriate directories or folders and 

the printing of documents to the required specifications 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide. 

2. Follow the instructions described below 3 to 6. 

3. Read the information written in the information ―Sheet 1 and Sheet 5. 

4. Accomplish the ―Self-check1 to Self-check 5 in page -83, 87, 90, 92, and 97 respectively. 

5. If you earned a satisfactory evaluation from the ―Self-check‖ proceed to ―Operation Sheet 1 to 

5 in page -84, 88, 91, 93, and 99 respectively. 

6. Do the ―LAP test‖ in page – 99 (if you are ready). 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet -1 
Inserting standard table  

 

Tables help your present information in a clear and organized way. There are three ways to add tables 

to your documents in Microsoft Word, each taking only a few easy steps.  

Creating a table by highlighting rows and columns in Word  

To create a table by highlighting rows and columns, follow these steps: 

1. Click the Insert tab. 

2. Move the cursor where you want to insert a table in your document. 

3. Click the Table icon. A pull-down menu appears. 

 

                            Figure 1. Inserting table 

 

4. The Table pull-down menu displays squares that represent the number of rows and columns for 

your table. 

5. Move the mouse pointer to highlight the number of rows and columns you want to create for 

your table. 

6. When you highlight rows and columns, Word displays your table directly in your document so 

you can see exactly what your table will look like. 

7. Click the left mouse button when you’re happy with the size of your table. 

https://computer.howstuffworks.com/microsoft.htm


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-1 
Written test  

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. Write the important of table. (6points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 6points  Unsatisfactory - below 6 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet sheet -1 
Inserting table 

 

Steps to create a table by highlighting rows and columns 

1. Click the Insert tab. 

2. Move the cursor where you want to insert a table in your document. 

3. Click the Table icon 

4. The Table pull-down menu displays squares that represent the number of rows and columns for 

your table. 

5. Move the mouse pointer to highlight the number of rows and columns you want to create for 

your table. 

6. When you highlight rows and columns, Word displays your table directly in your document so 

you can see exactly what your table will look like. 

7. Click the left mouse button when you‘re happy with the size of your table. 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet -2 
Changin cells (insert and delete columns and rows) 

Row and Column Basics 

MS Excel is in tabular format consisting of rows and columns. 

 Row runs horizontally while Column runs vertically. 

 Each row is identified by row number, which runs vertically at the left side of the sheet. 

 Each column is identified by column header, which runs horizontally at the top of the sheet. 

Insert or delete rows, and columns 

Insert and delete rows and columns to organize your worksheet better. 

1. Select any cell within the column, then go to Home > Insert > Insert Sheet 

Columns or Delete Sheet Columns. 

2. Alternatively, right-click the top of the column, and then select Insert or Delete.  

Or 

    Insert or delete a row 

1. Select any cell within the row, then go to Home > Insert > Insert Sheet Rows or Delete Sheet 

Rows. 

2. Alternatively, right-click the row number, and then select Insert or Delete. 

 

2.2. Formatting options 

When you select a row or column that has formatting applied, that formatting will be transferred to a 

new row or column that you insert. If you don't want the formatting to be applied, you can select 

the Insert Options button after you insert, and choose from one of the options as follows: 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

                                            Figure 1: Excel row and column 

 

If the Insert Options button isn't visible, then go to File > Options > Advanced > in the Cut, copy and 

paste group, check the Show Insert Options buttons option. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-2 
Written test  

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. Write the basics of row and column. (6points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating - 6points  Unsatisfactory - below 6 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -2 
Inserting or delete row and column 

Steps to insert or delete rows and columns   

Insert or delete a columns 

1. Select any cell within the column, then go to Home > Insert > Insert Sheet 

Columns or Delete Sheet Columns. 

2. Alternatively, right-click the top of the column, and then select Insert or Delete.  

Or 

Insert or delete a row 

1. Select any cell within the row, then go to Home > Insert > Insert Sheet Rows or Delete 

Sheet Rows. 

2. Alternatively, right-click the row number, and then select Insert or Delete. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet -3 
Inserting appropriate images to documents  

Insert image in to document 

Although adding pictures to text is often thought of more with desktop publishing programs such as 

Microsoft Publisher, you can also insert photos into your Microsoft Word documents. Putting photos in 

a Word document makes it more interesting and highlights points raised in the text, whether it's a 

news release about a new product or a vacation photo in a Christmas letter. Adding photos to a Word 

document is an easy process, with the command locations differing only by the version of Word you 

are using. Following are instructions in how to put photos in a Microsoft Word document for Word 2007 

and 2010. 

Steps, inserting documents and images 

1. Open the Word document that you want to insert a photo  

2. Click the place in your document where you want the picture to appear.  

3. Access the "Insert Picture" dialog box.  

4. Browse to the photo you want to insert. 

5. Click the file, then click "Insert. 

6. Modify the picture as necessary. 

 

                                           Figure 1. Insert picture into MS words 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-3 
Written test  

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. Write the important of adding image in to document. (5points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 5 points  Unsatisfactory - below 5points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -3 
Inserting documents and images 

Steps, inserting documents and images 

1. Open the Word document that you want to insert a photo in 

2. Click the place in your document where you want the picture to appear.  

3. Access the "Insert Picture" dialog box.  

4. Browse to the photo you want to insert. 

5. Click the file, then click "Insert. 

6. Modify the picture as necessary. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-4 Creating folders  

 Folder means 

In computers, a folder is the virtual location for applications, documents, data or other sub-folders. 

Folders help in storing and organizing files and data in the computer. The term is most commonly used 

with graphical user interface operating systems. 

To create a new folder in the Documents library: 

1. Choose Start Documents. 

The Documents library opens. 

2. Click the New Folder button in the command bar. 

An icon for the new folder appears in the content area, with the name New folder next to it, already 

selected. 

 

                                                 Figure 1. Create new folder 

3. Type the name you intend to give to the new folder. 

Don‘t move the cursor or mouse before you start typing. Your new text will replace the highlighted text 

automatically. 

4. Press the Enter key to make the new name stick. 

You can open your new folder by double-clicking its icon. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-4 
Written test  

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. What is folder? (5points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 5 points  Unsatisfactory - below 5points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -4 
Creating  folder 

Steps to create a new folder in the Documents library: 

1. Choose Start Documents. 

2. The Documents library opens. 

3. Click the New Folder button in the command bar. 

4. An icon for the new folder appears in the content area, with the name new folder next to it, 

already selected. 

5. Type the name you intend to give to the new folder. 

6. Don‘t move the cursor or mouse before you start typing. Your new text will replace the 

highlighted text automatically. 

7. Press the Enter key to make the new name stick. 

8. You can open your new folder by double-clicking its icon. 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet -5 
Printing document  

 

5.1 Printer 

A printer is a device that accepts text and graphic output from a computer and transfers the 

information to paper, usually to standard size sheets of paper. Printers vary in size, speed, 

sophistication, and cost. In general, more expensive printers are used for higher-resolution color 

printing. 

5.1.1 Printing a documents 

To print a document, your computer needs to be connected to a printer. Being able to print is not 

necessary in order to use Word, but if you want to send a letter in the post or print out a poster, you‘ll 

need to have access to a printer. 

You’ll need: 

 A computer with Microsoft Word installed 

 A printer set up and connected to your computer (wireless or connected by cable) 

Follow these step-by-step instructions to print a document from Microsoft Office  

Step 1: Open an existing Microsoft Word document or start a new document, if you have Windows 10 

you can use Cortana to search for it. Before you print, type your text in the blank document or insert an 

image.  

Step 2: When you are ready, click on File in the top left-hand corner of your document. Then, click on 

Print.  

 

Step 3: For Office 365, click on File then Print in the menu, this will bring up the ‗Print‘ dialogue box. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Step 5: Depending on your printer options, you can choose other printing features such as whether 

you want to print all pages or only certain pages.  

Step 6: When you‘re happy with your settings, click Print. The document will now start printing on 

your printer. 

 

                                                                      Print 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-5 
Written test  

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. What is printer? (5points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 5 points  Unsatisfactory - below 5points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -5 
Printing documents 

 

Follow these step-by-step instructions to print a document from Microsoft Office  

Step 1: Open an existing Microsoft Word document or start a new document 

Step 2: When you are ready, click on File in the top left-hand corner of your document. Then, click on 

Print. 

Step 3: click on File then Print in the menu, this will bring up the ‗Print‘ dialogue 

Choose how many copies of your document you need and click on the printer you wish to use. You will 

have to have your printer already installed on your computer.  

Step 5: choose other printing features such as whether you want to print all pages or only certain 

pages.  

Step 6: click Print. The document will now start printing on your printer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________   Time finished:  ________________ 

                   Instruction: Given necessary templates, tools and materials you are required to perform the following 

tasks within 3 hours. 

Task 1. Insert table in to MS word 

Task 2. Insert and delete row and column  

Task 3. Insert documents and images  

Task 4. Create folder 

Task 5. Print a documents  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LAP Test  Practical Demonstration 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

  

 

https://www.wikihow.com/Print-a-Word-Document 

https://support.office.com/en-us/article/insert-a-table-a138f745-73ef-4879-b99a-2f3d38be612a 

https://www.webucator.com/how-to/how-create-new-folder-windows-10.cfm 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

List of reference and materials 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

      Horticultural Crops Production 
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Instruction sheet Learning Guide #12 

 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics –  

 Selecting spreadsheet software  

 Identifying document purpose, audience and presentation requirements 

 spreadsheet application  

 Entering simple formulas and functions  

 Using a range of common tools  

 Editing columns and rows  

 Using the auto-fill function  

 naming and storing of documents  

 printing of documents  

This guide will also assist you to attain the learning outcome stated in the cover page. Specifically, 

upon completion of this Learning Guide, you will be able to – 

 Select spread sheet software appropriate  

 Identify document purpose, audience and presentation requirements  

 Open the spread sheet application, create and number spread sheet files 

 Enter simple formulas and functions using cell referencing  

 Use a range of common tools during spread sheet development 

 Edit columns and rows in the the spread sheet 

 Use the auto-fill function to increment data  

 Ensure the naming and storing of documents in appropriate directories 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide. 

2. Follow the instructions described below 3 to 6. 

3. Read the information written in the information ―Sheet 1 to 7. 

4. Accomplish the ―Self-check1 to Self-check 7 in page -105, 108, 111,125, 133, and 138 respectively. 

5. If you earned a satisfactory evaluation from the ―Self-check‖ proceed to ―Operation Sheet 1to 4 in page -

112, 126, 134 and respectively. 

6. Do the ―LAP test‖ in page – 140 (if you are ready) 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-1 Selecting spread sheet software appropriate  

 

1.1 Spreadsheet software 

Spreadsheet software is a software application capable of organizing, storing and analyzing data in 

tabular form. The application can provide digital simulation of paper accounting worksheets. They can 

also have multiple interacting sheets with data represented in text, numeric or in graphic form. With 

these capabilities, spreadsheet software has replaced many paper-based systems, especially in the 

business world. 

Spreadsheets can do practically anything. They can host your to-do list, help you reach your goals, 

and lead you to make better decisions. There's almost nothing you can't track using spreadsheet 

software. 

1.1.1 The 8 Best Spreadsheet Apps 

 Microsoft Excel for powerful data crunching and large data sets 

 Google Sheets for spreadsheet collaboration 

 LibreOffice Calc for a free, native spreadsheet app 

 Smart sheet for project management and other non-spreadsheet tasks 

 Quip for integrating spreadsheets into shared documents 

 Zoho Sheet for a free, feature-rich solution 

 EtherCalc for creating a collaborative spreadsheet without an account 

 Air table for database management. 

 

1.2 Spreadsheet overview 

Below is a basic example of what a Microsoft Excel spreadsheet looks 

like, with all the important features of a spreadsheet highlighted. 

https://zapier.com/blog/google-sheets-to-do-list/
https://zapier.com/blog/smart-goals/
https://zapier.com/blog/decision-matrix-template/
https://zapier.com/blog/best-spreadsheet-excel-alternative/#Excel
https://zapier.com/blog/best-spreadsheet-excel-alternative/#Google%20Sheets
https://zapier.com/blog/best-spreadsheet-excel-alternative/#LibreOffice
https://zapier.com/blog/best-spreadsheet-excel-alternative/#Smartsheet
https://zapier.com/blog/best-spreadsheet-excel-alternative/#Quip
https://zapier.com/blog/best-spreadsheet-excel-alternative/#Zoho%20Sheet
https://zapier.com/blog/best-spreadsheet-excel-alternative/#EtherCalc
https://zapier.com/blog/best-spreadsheet-excel-alternative/#Airtable
https://www.computerhope.com/comp/msoft.htm
https://www.computerhope.com/excel.htm


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

                                           Figure 1. Spreadsheet view 

Computer has made our life easier than ever before. Now we can not only record our data precisely, 

but analysis and working with data is also very easy. Different programs are useful in this regard, but 

Microsoft excel is the most commonly used program.   

 

1. Work book. 

A file, which contain sheet to work on, is called as workbook. If we take the example of Microsoft 

Excel, a workbook contains three worksheets. Many other programs also have workbooks, which are 

used for the same purpose. Number of work sheet in work book varies with the program used. 

2. Spreadsheet 

Spreadsheet is the main working space of any such program. When we open a program like Excel, we 

load a spreadsheet, which further contains workbooks and worksheets. Hence, spreadsheet is a larger 

program, as compare to others. 

3. Worksheet 

The sheet on which data is actually recorded is called as work sheet. Different formulas are applied for 

the analysis of data on the work sheet. So, we can say that worksheet is the working table of excel. It 

is the single sheet 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-1 
Written test  

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

4. What is spreadsheet? (5points) 

5. Write the difference b/n spreadsheet and worksheet. (10 points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 15 points  Unsatisfactory - below 15points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-2 Spreadsheet Applications 

 

Spreadsheets are frequently used to record information and perform calculations on the results 

of investigations and experiments.  In mathematics, spreadsheets are particularly useful when a 

number of repetitive calculations need to be performed.  The main features of the Microsoft® 

Excel spreadsheet are described below.  Open a new Excel spreadsheet to help you identify the 

features described. 

Rows, columns and cells 

 Horizontal rows are labelled 1, 2, 3, 4, … and vertical columns are labelled A, B, C, D, … 

 The intersection of a row and a column is called a cell. 

 The cell at the intersection of column A and row 1 is referred to as A1. 

 The highlighted rectangle on the screen is called the cell pointer and the cell containing 

the cell pointer is called the active cell. 

 Note that Excel contains 256 columns labelled A, B, C, …, AA, AB, …, AZ, …, BA, BB, 

BC, …, BZ, CA, CB, CC, …, CZ, …. and it contains 65 536 rows labelled from 1 to 65 

536. 

 

 Figure 1. Spreadsheet application 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Standard toolbar 

The Standard toolbar provides easy access to frequently used functions such as save, cut, copy, 
paste, etc. 

 

 

Formatting toolbar 

The Formatting toolbar provides easy access to commands such as bold, italics, font, alignment of 
text, etc. 

 

 
 

  

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-2 
Written test  

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. List the standard toolbar? (5points) 

2. List the formatting toolbar. (5 points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet   

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 10 points  Unsatisfactory - below 10points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-3 Entering simple formulas and functions 

 

Formulas are the real workhorses of an Excel worksheet. If you set up a formula properly, it computes 

the correct answer when you enter it into a cell. You can set up a formula from the functions excel 

provides or create your own custom excel function. From then on, it keeps itself up to date, 

recalculating the results whenever you change any of the values that the formula uses. 

This Mathematical Operator . . . . . . Is Used For 

+ (plus, sign) Addition 

– (minus sign or hyphen) Subtraction 

* (asterisk) Multiplication 

/ (slash) Division 

^ (caret) Raising a number to an exponential power 

For example, to create a formula in cell C2 that multiplies a value entered in cell A2 by a value in cell 

B2, enter the following formula in cell C2: =A2*B2 

To enter this formula in cell C2, follow these step 

1. Select cell C2. 

2. Type the entire formula =A2*B2 in the cell 

OR 

1. Select cell C2. 

2. Type = (equal sign). 

3. Select cell A2 in the worksheet by using the mouse or the keyboard 

4. Type * (Shift+8 on the top row of the keyboard). 

5. Select cell B2 in the worksheet by using the mouse or the keyboard 

6. Press Enter. 

Excel displays the calculated answer in cell C2 and the formula =A2*B2 in the Formula bar  

 

https://www.dummies.com/software/microsoft-office/excel/scrolling-through-an-excel-2010-worksheet/
https://www.dummies.com/software/microsoft-office/excel/how-to-create-custom-excel-functions
https://www.dummies.com/software/microsoft-office/excel/how-to-enter-basic-formulas-in-excel-2010/


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

Figure 1: Excel spreadsheet 

  

 

 

 

 

 

 

 

 

https://courses.corporatefinanceinstitute.com/courses/free-excel-crash-course-for-finance


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-3 
Written test  

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. What is formula? (5points)  

2. List mathematical operators. (5points) 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 10 points  Unsatisfactory - below 10 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet-3 Entering the  formula in cell C2 

 

 Step to enter the formula in cell C2  

1. Select cell C2. 

2. Type = (equal sign). 

3. Select cell A2 in the worksheet by using the mouse or the keyboard 

4. Type * (Shift+8 on the top row of the keyboard). 

5. Select cell B2 in the worksheet by using the mouse or the keyboard 

6. Press Enter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information Sheet-4 Using a range of common tools  

4.1. Spreadsheet Tools 

While the data management and graphing features of spreadsheet programs are well-known, powerful 

programs like Microsoft Excel include a large number of additional tools that can be used to great 

effect in a course. 

The details of how to use the following list of tools in Microsoft Excel are described below.  

 Specialized functions  

  Fill data series  

 Generating tables of data  

  Statistical tools  

  Numerically solving simultaneous equations  

 Optimization  

 Matrix algebra operations 

1. Specialized functions 

Excel provides a wide variety of built-in formulas for completing a number of computations. Aside from 

a wide array of standard statistical, financial, and mathematical functions, Excel has a number of 

logical operators, database management tools, and formulas for making time calculations. 

2. Fill data series 

Spreadsheet programs contain a feature that will allow a column or row of numbers to be automatically 

generated. In Excel, this command can be used to create data with linear or growth characteristics or 

may be used to estimate the trend series of existing data. 

https://serc.carleton.edu/sp/library/spreadsheets/do.html#special
https://serc.carleton.edu/sp/library/spreadsheets/do.html#fill
https://serc.carleton.edu/sp/library/spreadsheets/do.html#tables
https://serc.carleton.edu/sp/library/spreadsheets/do.html#stats
https://serc.carleton.edu/sp/library/spreadsheets/do.html#simul
https://serc.carleton.edu/sp/library/spreadsheets/do.html#opt
https://serc.carleton.edu/sp/library/spreadsheets/do.html#matrix
https://serc.carleton.edu/sp/library/spreadsheets/do.html#fill


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

3. Data tables 

Data tables in Excel may be used to automatically create an array of data from three-variable 

equations. The table is set up so that values for two independent variables are entered on the edges, 

and the middle of the table contains the data for the dependent variable.  

4. Statistical tools 

Excel has a number of built-in statistical tools that are useful in a variety of situations. An option in 

scatter plot charts of data allows a regression (trend) line to be plotted and the equation and R-

squared value to be displayed. Basic ordinary least squares linear regressions are straightforward to 

compute, as are a variety of hypothesis test statistics and analyses of distribution functions. 

5. Solving simultaneous equations 

Many users have been frustrated by the "cannot resolve circular references" error message Excel 

returns when two formulas refer to each other. However, an option in Excel allows the user to resolve 

these circular references by solving the equations through a numerical method.  

6. Optimization 

The Solver Add-in for Excel allows Excel to find an optimal solution for a system of formulas 

programmed in a spreadsheet. Specifically, Solver can be directed to find the minimum value, 

maximum value, or any specific value for a formula cell by changing the value(s) in other specified 

cells(s).  

7. Matrix Algebra 

Excel can manipulate data as vectors or matrices and can compute some basic matrix operations. 

This is sometimes useful when presenting more advanced topics in mathematics or statistics. 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-3 
Written test  

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. What function of spreadsheet tool? (5points)  

2.  List and describe the tools in Microsoft Excel (10 points) 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 15 points  Unsatisfactory - below 15 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-5 Editing columns and rows on spread sheet 

5.1. Difference columns and rows 

Mixing up the definition of rows and columns is easy, but knowing the difference is important when 

learning how to structure a spreadsheet or when following a tutorial. 

Columns run vertically, up and down. Using the image above, we can see that A, B, and C are 

columns because they're located at the top of the spreadsheet. They're there to align the cells below 

them. Most spreadsheet programs mark columns headings with letters. 

Rows, then, are the opposite of columns and run horizontally. The rows in our image include 1, 2, 3, 4, 

and 5. 

One easy way to remember the difference between columns and rows is to think about real-world 

scenarios. A column on a building is a large, vertical pillar, while the rows of a corn field are long 

aisles. 

5.2. Working with columns, rows, and cells 

By default, every row and column of a new workbook is set to the same height and width. Excel 

allows you to modify column width and row height in different ways. 

Optional: You can download this example for extra practice. 

To modify column width: 

1. Position your mouse over the column line in the column heading so the white cross

becomes a double arrow . 

 

https://www.lifewire.com/column-and-row-headings-3123610
https://media.gcflearnfree.org/ctassets/topics/175/Excel2010_ModColumns_Practice.xlsx


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

2. Click and drag the column to the right to increase column width or to the left to 

decrease column width. 

 

3. Release the mouse. The column width will be changed in your spreadsheet. 

 

If you see pound signs (#######) in a cell, it means the column is not wide enough to display the cell 

content. Simply increase the column width to show the cell content. 

To modify row height: 

1. Position the cursor over the row line so the white cross becomes a double arrow . 

 

2. Click and drag the row downward to increase row height or upward to decrease height. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

3. Release the mouse. The height of each selected row will be changed in your worksheet. 

 

To insert rows: 

1. Select the row below where you want the new row to appear. 

 

2. Click the Insert command on the Home tab. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

3. The new row appears in your worksheet. 

 

When inserting new rows, columns, or cells, you will see the Insert Options button by the inserted 

cells. This button allows you to choose how Excel formats them. By default, Excel formats inserted 

rows with the same formatting as the cells in the row above them. To access more options, hover your 

mouse over the Insert Options button and click the drop-down arrow that appears. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

To insert columns: 

1. Select the column to the right of where you want the new column to appear. For 

example, if you want to insert a column between A and B, select column B. 

 

2. Click the Insert command on the Home tab. 

 

3. The new column appears in your worksheet. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

By default, Excel formats inserted columns with the same formatting as the column to the left of them. 

To access more options, hover your mouse over the Insert Options button and click the drop-down 

arrow that appears. 

 

When inserting rows and columns, make sure to select the row or column by clicking its heading so all 

of the cells in that row or column are selected. If you select just a cell in the row or column, only a new 

cell will be inserted. 

To delete rows: 

1. Select the rows you want to delete. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

2. Click the Delete command on the Home tab. 

 

3. The rows are deleted from your worksheet. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

To delete columns: 

1. Select the columns you want to delete. 

 

2. Click the Delete command on the Home tab. 

 

3. The columns are deleted from your worksheet. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

1. Edit menu, click Paste Special, select Column Widths, and then click OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-5 
Written test  

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. Write the difference b/n columns and rows? (6points)  

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet    

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 6points  Unsatisfactory - below 6 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet-5 
Working with columns and rows  

Steps to modify column width: 

1. Position your mouse over the column line in the column heading so the white 

cross becomes a double arrow . 

2. Click and drag the column to the right to increase column width or to the left to 

decrease column width. 

3. Release the mouse. The column width will be changed in your spreadsheet. 

Steps to modify row height: 

8. Position the cursor over the row line so the white cross becomes a double arrow . 

9. Click and drag the row downward to increase row height or upward to decrease height. 

10. Release the mouse. The height of each selected row will be changed in your worksheet. 

Steps to insert rows: 

1. Select the row below where you want the new row to appear. 

2. Click the Insert command on the Home tab. 

3. The new row appears in your worksheet. 

Steps to insert columns: 

1. Select the column to the right of where you want the new column to appear. For 

example, if you want to insert a column between A and B, select column B. 

2. Click the Insert command on the Home tab. 

3. The new column appears in your worksheet. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Steps to delete rows: 

1. Select the rows you want to delete. 

2. Click the Delete command on the Home tab. 

3. The rows are deleted from your worksheet. 

Steps to delete columns: 

1. Select the columns you want to delete. 

2. Click the Delete command on the Home tab. 

3. The columns are deleted from your worksheet. 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-6 
Using the auto-fill functions 

 

6.1. AutoFill  

AutoFill is a very useful Excel feature. It allows you to create entire columns or rows of data which are 

based on the values from other cells. In other words, Excel compares the selected data and tries to 

guess the next values that will be inserted.  

Use AutoFill in Excel to automatically fill a series of cells. This page contains many easy to follow 

AutoFill examples. The sky is the limit! 

1. For example, enter the value 10 into cell A1 and the value 20 into cell A2. 

 

2. Select cell A1 and cell A2 and drag the fill handle down. The fill handle is the little green box at the 

lower right of a selected cell or selected range of cells. 

 

Note: AutoFill automatically fills in the numbers based on the pattern of the first two numbers. 

3. Enter Jan into cell A1. 

 

4. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the month names. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

5. Enter Product 1 into cell A1. 

 

6. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the product names. 

 

7. Enter Friday into cell A1. 

 

8. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the day names. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

9. Enter the date 1/14/2019 into cell A1. 

 

10. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the days. 

 

11. Instead of filling in days, use the AutoFill options to fill in weekdays (ignoring weekend days), 

months (see example below) or years. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Note: also see the options to fill the formatting only and to fill a series without formatting. 

12. Enter the date 1/14/2019 into cell A1 and the date 1/21/2019 into cell A2. 

 

13. Select cell A1 and cell A2 and drag the fill handle down. AutoFill automatically fills in the dates 

based on the pattern of the first two dates. 

 

14. Enter the time 6:00 AM into cell A1. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

15. Select cell A1 and drag the fill handle across. AutoFill automatically fills in the times. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-6 
Written test  

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. What is auto fill? (6points)  

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet    

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 6points  Unsatisfactory - below 6 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet-6 
Using auto fill  

Steps to use auto fill 

1. For example, enter the value 10 into cell A1 and the value 20 into cell A2. 

2. Select cell A1 and cell A2 and drag the fill handle down. The fill handle is the little green box at the 

lower right of a selected cell or selected range of cells. 

3. Enter Jan into cell A1. 

4. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the month names. 

5. Enter Product 1 into cell A1. 

6. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the product names. 

7. Enter Friday into cell A1. 

8. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the day names. 

9. Enter the date 1/14/2019 into cell A1. 

10. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the days. 

11. Instead of filling in days, use the AutoFill options to fill in weekdays (ignoring weekend days), 

months (see example below) or years. 

12. Enter the date 1/14/2019 into cell A1 and the date 1/21/2019 into cell A2. 

13. Select cell A1 and cell A2 and drag the fill handle down. AutoFill automatically fills in the dates 

based on the pattern of the first two dates. 

14. Enter the time 6:00 AM into cell A1. 

15. Select cell A1 and drag the fill handle across. AutoFill automatically fills in the times. 

  

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-7 
Naming and storing of documents  

 

7.1 File naming   

How you organize and name your files will have a big impact on your ability to find those files later and 

to understand what they contain. You should be consistent and descriptive in naming and organizing 

files so that it is obvious where to find specific data and what the files contain. 

It's a good idea to set up a clear directory structure that includes information like the project title, a 

date, and some type of unique identifier. Individual directories may be set up by date, researcher, 

experimental run, or whatever makes sense for you and your research. 

7.2 save a document 

If you‘ve written a bestseller or created a newsletter, you‘ll probably want to save it somewhere so that 

you can get to it again for printing or sending by email. You may also have started a document but 

want to finish it off later. 

Follow these step-by-step instructions to save a document 

Step 1: Start a new document in Word and type your text. 

Step 2: Click File in the top left-hand corner of the screen. 

 

Step 3: From the menu, choose Save. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Step 4: A ‗Save‘ dialogue box will come up.  

 

Step 5: Word will automatically give your document a name, based on the first few words of your text. 

If you don‘t like the one given, once you have chosen the destination folder, type a name for your 

document in the ‗File name‘ box.  



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Step 6: Once you have typed in the name of your document, click Save. 

 

Step 7: Your document will now have a name,  

Step 8: The ‗Save As‘ menu – the link to which is on the left-hand side of the ‗File‘ dialogue box, 

beneath ‗Save‘ – is used to save an existing document under another name.  

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-check-7 
Written test  

 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next page 

1. Define file naming and file saving? (8points)  

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet    

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Satisfactory rating – 8 points  Unsatisfactory - below 8 points  

 

Score = ___________ 

Rating= ____________ 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet-7 
Saving a document 

 

Step-by-step instructions to save a document 

      Step 1: Start a new document in Word and type your text. 

      Step 2: Click File in the top left-hand corner of the screen. 

      Step 3: From the menu, choose Save. 

      Step 4: A ‗Save‘ dialogue box will come up.  

      Step 5: Automatically give your document a name, based on the first few words of   your text. 

      Step 6: Once you have typed in the name of your document, click Save. 

      Step 7: Your document will now have a name,  

Step 8: The ‗Save As‘ menu – the link to which is on the left-hand side of the ‗File‘ dialogue box,                           

beneath ‗Save‘ – is used to save an existing document under another name. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________   Time finished:  ________________ 

                   Instruction: Given necessary templates, tools and materials you are required to perform the following 

tasks within 2 hours. 

Task 1. Enter the formula in cell C2 

Task 2. Edite rows and columns  

Task 3. Use auto fill  

Task 4. Save documents  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LAP Test  Practical Demonstration 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 https://www.dummies.com/software/microsoft-office/excel/how-to-enter-basic-formulas-in-excel-2010/ 

    https://blog.nhlearningsolutions.com/blog/how-to-use-autofill-in-microsoft-excel 

 https://www.wikihow.com/Save-a-Microsoft-Word-Document 
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Instruction sheet Learning Guide #13 

 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics –  

 Importing an object to active spread sheet  

 Manipulating imported object using formatting features 

 Creating a chart using selected data  

 Displaying selected data in a different chart 

 Modifying chart is modified using formatting features 

This guide will also assist you to attain the learning outcome stated in the cover page. Specifically, 

upon completion of this Learning Guide, you will be able to – 

  Import an object into an active spread sheet 

  Manipulate imported object by using formatting features 

 Create a chart using selected data in the spread sheet 

 display selected data in a different chart 

 modify chart using formatting features 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide. 

2. Follow the instructions described below 3 to 6. 

3. Read the information written in the information ―Sheet 1 and Sheet 2. 

4. Accomplish the ―Self-check1 and Self-check 2 in page -61 and 68 respectively. 

5. If you earned a satisfactory evaluation from the ―Self-check‖ proceed to ―Operation Sheet 

1 in page -62. 

6. Do the ―LAP test‖ in page – 69 (if you are ready). 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-1 Importing an object to active spread sheet  

 

1.1. Defining Template Categories 

Follow these steps: 

1. In the Setup and Maintenance work area, go to the Manage Common Lookups task. 

2. On the Manage Common Lookups page, search for the lookup 

type ORA_HRC_DL_TEMPLATE_CATEGORY. 

3. In the search results, select ORA_HRC_DL_TEMPLATE_CATEGORY to display its lookup 

codes. 

4. Click the New icon to add a row to the lookup codes table. 

5. Define the lookup codes for your categories. For example, to create a category for worker 

templates: 

a. Enter WORKER_TEMPLATES in the Lookup Code field. 

b. Enter Worker in the Meaning field. This value appears in the list of categories on the Manage 

Spreadsheet Templates page, for example 

1.2. Importing Job Objects to the Spreadsheet 

1. Open the SalesJobs.xlsx spreadsheet and sign in when prompted. 

2. On the Spreadsheet Loader toolbar, click Import File. 

3. Complete the fields of the Import from File dialog box as shown in this table 

4. Click OK. The data set name is generated automatically. 

5. Correct any Import File Errors reported in the Progress and Message columns of the 

Spreadsheet Line Status section of the spreadsheet 

1.3. Import one file with one object type 

Follow these steps when your file contains only one object type (e.g., the file contains only contacts). 

 Ensure that your import file is already set up correctly. 

 In your HubSpot account, navigate to your contacts, companies, deals, tickets, or products. 

https://knowledge.hubspot.com/articles/kcs_article/contacts/set-up-your-import-file
https://knowledge.hubspot.com/articles/kcs_article/account/a-guide-to-hubspots-new-navigation


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 In the upper right, click Import. 

 Click Start an import. 

 Select File from computer, then click next. 

 Select one file, then click next. 

 Select one object, then click next. 

 Select the object type in your import file. 

 Click choose a file and in the dialog box, select your import file. Select the checkbox if 

you're using the object ID to deduplicate your contacts, companies, deals, tickets, or products. 

In the bottom right, click Next 

1.4. Import one file with multiple object types 

Follow these steps when your single file contains more than one type of object (e.g., the file contains 

contacts, deals and notes). 

 Ensure that your import file is already set up correctly. 

 In your Hub Spot account, navigate to your contacts, companies, deals, tickets, or products.  

 In the upper right, click Import. 

 Click Start an import. 

 Select File from computer, then in the bottom right, click Next. 

 Select one file, and click next. 

 Select multiple objects, and click next. 

 Select the types of objects in your import file. Then, click next. 

 Click choose a file, then select your import file. If you're using the object ID to deduplicate 

your contact, company, deal, or ticket records, select the Update existing records using 

“Object ID” exported from HubSpot checkbox. 

 Click Next  

 

 

https://knowledge.hubspot.com/articles/kcs_article/contacts/how-does-hubspot-deduplicate-contacts#object-id
https://knowledge.hubspot.com/articles/kcs_article/contacts/set-up-your-import-file
https://knowledge.hubspot.com/articles/kcs_article/account/a-guide-to-hubspots-new-navigation
https://knowledge.hubspot.com/articles/kcs_article/contacts/how-does-hubspot-deduplicate-contacts#object-id
https://knowledge.hubspot.com/articles/kcs_article/contacts/how-does-hubspot-deduplicate-contacts#object-id


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

1. How to Import one file with one object type? 10 points 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Short Answer  

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 10 points            Unsatisfactory - below 10 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-2 Creating a chart using selected data  

 

2.1. Graphs and Charts in Excel 

Charts and graphs elevate your data by providing an easy-to-understand visualization of numeric 

values.  While the terms are often used interchangeably, they are slightly different. Graphs are the 

most basic way to represent data visually, and typically display data point values over a duration of 

time. Charts are a bit more complex, as they allow you to compare pieces of a data set relative to the 

other data in that set. Charts are also considered more visual than graphs, since they often take a 

different shape than a generic x- and y-axis. 

2.2. Make a Chart in Excel 

Step 1: Select Chart Type 

 

Step 2: Create Your Chart 

Step 3: Add Chart Elements 

 

 

2.3. Make a Graph in Excel 

Although graphs and charts are distinct, Excel groups all graphs under the chart‘s categories listed 

in the previous sections. To create a graph or another chart type, follow the steps below and select 

the appropriate graph type 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

2.4. Select Range to Create a Graph from Workbook Data 

1. Highlight the cells that contain the data you want to use in your graph by clicking and dragging 

your mouse across the cells. 

2. Your cell range will now be highlighted in gray 

3. Once the text is highlighted you can select a graph (which Excel refers to as chart). Click 

the Insert tab and click Recommended Charts on the toolbar. Then click the type of graph you 

wish to use 

 

                              Figure 1. Graph in Excel 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

1. Write difference between graphs and chart in excel?  6points 

2. How to Make a Graph in Excel? 6 points 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer Sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 12 points            Unsatisfactory - below 12 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet-2 Making a chart in Excel 

 

Steps to Make a Chart in Excel 

Step 1: Select Chart Type 

Step 2: Create Your Chart 

Step 3: Add Chart Elements 

Step 4: Highlight the cells that contain the data you want to use in your graph by clicking and dragging 

your mouse across the cells. 

Step 5: Your cell range will now be highlighted in gray 

Step 6: Once the text is highlighted you can select a graph (which Excel refers to as chart).  

Step 7: Click the Insert tab and click Recommended Charts on the toolbar.  

Step 8: Then click the type of graph you wish to use 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-3 Displaying selected data in a different chart 

 

3.1. Arrange data for charts 

Excel can recommend charts for you. The charts it suggests depend on how you‘ve arranged the data 

in your worksheet. You also may have your own charts in mind. Either way, this table lists the best 

ways to arrange your data for a given chart. 

Column, bar, line, area, 

surface, or radar chart. 

- 

Figure 1: bar char 

 

 

Pie chart 

This chart uses one set of 

values (called a data 

series). 

 

In one column or row, and one column or row of labels. 

 

Figure 2: pie chart 

https://support.office.com/en-gb/article/create-a-chart-with-recommended-charts-cd131b77-79c7-4537-a438-8db20cea84c0


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

Doughnut chart 

This chart can use one or 

more data series. 

 

In one or multiple columns or rows of data, and one column or row of 

labels. 

 

 Figure 3: Doughnut chart  

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

1. How can displaying your data? 8points 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer Sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 8 points            Unsatisfactory - below 8 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Once your chart appears in Excel, there are many ways to modify the way it looks and its location. A few 

ways are described below, but explore to find more! In all cases, you have to select the chart first to access 

Chart Tools. 

 To add any labels (for example, the title or axes), under the Design ribbon, click Add Chart Element 

in the Chart Layouts group and select the desired label. 

 To change the chart type, data, or location, use the Chart Tools Design ribbon. 

 

From the Chart Tools Format ribbon, you can select an element on the chart (for example, a series), 

then choose the Format Selection icon in the Current Selection group. With the Formatting Task pane, 

you can change the shape, style and color. 

 

 

Information sheet-4 Modifying chart using formatting features 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

                                          Figur1. Modified Chart in Excel 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -5 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

1. Write some formatting feature to modifying charts?  10 points 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer Sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 10 points            Unsatisfactory - below 10 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________   Time finished:  ________________ 

                   Instruction: Given necessary templates, tools and materials you are required to perform the following 

tasks within 30 minutes. 

Task 1. Make a chart in Excel 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LAP Test  Practical Demonstration 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

         www. docs.oracle.com › cloud › saas › applications-common › faihm › imp.. 

    www. knowledge.hubspot.com › contacts › import-object 

         www.smartsheet.com › how-to-make-charts-in-exce 
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Instruction sheet Learning Guide #14 

 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics –  

 designing database application  

 Developing table  

 Creating a primary key and establish an index  

 Modifying table layout and field attributes  

 Creating a relationship 

 Adding and modifying data in a table  

 Adding and deleting records  

 Saving and close down database  

This guide will also assist you to attain the learning outcome stated in the cover page. Specifically, 

upon completion of this Learning Guide, you will be able to – 

  Open a database application and design a two-table, simple relational database 

incorporating basic design principles 

 Develop a table with fields and attributes according to database usage 

 Create a primary key and establish an index for each table 

 Modify table layout and field attributes as required 

 Create a relationship between the two tables 

 Add and modify data in a table according to information requirements 

 Add and delete records as required 

 Save and close down database to storage area 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide. 

2. Follow the instructions described below 3 to 6. 

3. Read the information written in the information ―Sheet 1 to Sheet 6. 

4. Accomplish the ―Self-check1 to Self-check 6 in page -168, 171, 173, 176, 179, and 183 respectively. 

5. If you earned a satisfactory evaluation from the ―Self-check‖ proceed to ―Operation Sheet 1and 2 in 

page -169 and 184 respectively. 

6. Do the ―LAP test‖ in page – 185 (if you are ready). 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-1 Designing a database application   

 

1.1 Database 

More specifically, a database is an electronic system that allows data to be easily accessed, 

manipulated and updated. In other words, a database is used by an organization as a method of 

storing, managing and retrieving information. Modern databases are managed using 

a database management system (DBMS). 

1.2  Creating a database 

The steps in which you will be able to create an Excel base database. 

Step 1: Entering the data 

The columns in a database are called fields. You can add as many may be necessary. 

So, the Fields of this database are StdID, StdName, State, Age, Department, and Class Teacher. 

 

You can now enter data into the database easily. Every new input will be added to the first empty 

row after the Fields. 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Say this is the input which has to be inserted in the database: 

StdID: 1030456042, 

StdName: Jemmy Fox, 

State is Oklahoma, 

Student age 25, 

Department CSE, 

And the class teacher is Mr. John. 

 

So, you see entering data into an Excel database is pretty basic. 

Step 2: Entering Data Correctly 

When you will enter data into a database, you cannot leave a row empty. This is strictly prohibited. 

Say after the last row, I put some data in the 2nd row from it: 

StdID is 103457045, 

StdName is Jackson, 

State is New York, 

Age 23, 

Department ETE, 

And the class teacher is Mr. Balmar. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

This is a clear breakdown of this database. 

Although it might happen that some of the cells in a row could be empty. Let‘s say something like 

this is legal. 

 

On the same lines, another rule is: there will be no completely empty column in a database. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Step 3: Know that the Rows are called Records 

The next thing you have to know is: each individual row in a database is known as records. 

All the rows are records. Here I have marked a few for clarity. 

 

Step 4: Know that the Columns are called Fields 

All these columns are Fields. The headings of the columns are known as Field Names. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

So StdID, StdName, State, Age, Department, and Class Teacher are six Field Names of this 

database. 

Note: It is important to format the Field Names differently than the other rows in the database. 

These table Field Names are formatted with different styles than other cells in the table. 

Step 5: Creating the Table 

To create a table: Just select any cell in the data range, Insert tab, and click on 

the Table command. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Create Table dialog box appears. I take what Excel suggest. Yes, my table has headers. Click OK, 

and a table is created. Tada!!! 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

You can filter data using the drop-down arrows that appear at the headings of each column. If you 

want to learn table manipulation more go visit the Table portion here. 

Step 6: Using the Database Tools 

The database tools can come in handy with your data analysis and interpretation. You can and 

should learn more about these tools here. 

Step 7: Expanding the Database 

Now that everything is up and running, you can start adding more fields and records (you see what 

I did there) to your database. It‘s as basic as Step 1. 

Step 8: Completing the Database Formatting 

The last and final step is formatting the database columns. There are so many tools to format the 

cells in a database. You can work with Cell Styles, you can use the styles under ―Format as Table‖ 

drop down, and you can work with the commands in the Format Cells dialog box. You can use 

Custom number format. All these techniques are described in our previous lectures.  

 

 

 

 

 

 

 

 

https://support.office.com/en-gb/article/Sort-data-in-a-range-or-table-62d0b95d-2a90-4610-a6ae-2e545c4a4654
https://support.office.com/en-us/article/Using-Access-or-Excel-to-manage-your-data-09576147-47d1-4c6f-9312-e825227fcaea


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

1. What is database? 5 points 

 

 

You can ask your teacher for the copy of the correct answers 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 5 points            Unsatisfactory - below 5 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -1 Creating Excel database 

 

Steps to create Excel database 

Step1. Entering the data 

Stape2. Entering data correctly 

Step3. Rows are records 

Step 4. Columns are fields  

Step5. Creating the table  

Step6. Using the database tools 

Step 7. Expanding the database  

Step 8.completing the database formatting 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-2 developing table in database  

 

2.1. Create a table 

A simple database, such as a contact list, might use only a single table. Many databases, however, 

use several tables. When you create a new database, you create a new file on your computer that 

acts as a container for all of the objects in your database, including your tables. 

You can create a table by creating a new database, by inserting a table into an existing database, 

or by importing or linking to a table from another data source — such as a Microsoft Excel 

workbook, a Microsoft Word document, a text file, or another database. When you create a new, 

blank database, a new, empty table is automatically inserted for you. You can then enter data in 

the table to start defining your fields. 

2.2  Create a new table in a new database 

Steps to create a new table in anew database 

1. Click File > New, and then select Blank desktop database. 

2. In the File Name box, type a file name for the new database. 

3. To browse to a different location and save the database, click the folder icon. 

4. Click Create. 

5. A new table is inserted in the database and the table opens in Datasheet view  

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

1. Write a procedure to create a new table in new database? 10 points 

 

 

You can ask your teacher for the copy of the correct answers 

 

  

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 10 points            Unsatisfactory - below 10 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-3 Creating a primary key and an index  

 

When you create a PRIMARY KEY constraint, a unique clustered index on the column or 

columns is automatically created if a clustered index on the table does not already exist and 

you do not specify a unique non clustered index. The primary key column cannot allow NULL 

values. 

3.1. To create a clustered index by using Object Explorer 

1. In Object Explorer, expand the table on which you want to create a clustered index. 

2. Right-click the Indexes folder, point to New Index, and select Clustered Index.... 

3. In the New Index dialog box, on the General page, enter the name of the new index in 

the Index name box. 

4. Under Index key columns, click Add.... 

5. In the Select Columns from table name dialog box, select the check box of the table column 

to be added to the clustered index. 

6. Click OK. 

7. In the New Index dialog box, click OK. 

3.2. To create a clustered index by using the Table Designer 

1. In Object Explorer, expand the database on which you want to create a table with a clustered 

index. 

2. Right-click the Tables folder and click New Table.... 

3. Create a new table as you normally would.  

4. Right-click the new table created above and click Design. 

5. On the Table Designer menu, click Indexes/Keys. 

6. In the Indexes/Keys dialog box, click Add. 

7. Select the new index in the Selected Primary/Unique Key or Index text box. 

8. In the grid, select Create as Clustered, and choose Yes from the drop-down list to the right 

of the property. 

9. Click Close. 

10. On the File menu, click Save table name. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

1. Write the steps to create a clustered index by using Object Explorer? 10 points 

 

 

You can ask your teacher for the copy of the correct answers 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 10 points            Unsatisfactory - below 10 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-4 Creating a relationship between the two tables 

 

4.1. Create a relationship between two tables 

I. To create a relationship between two tables in Diagram View (Right-click) 

2. In Visual Studio with Analysis Services projects, click the Model menu, then click Model 

View, and then click Diagram View. 

3. Right-click a table heading or column, and then click Create Relationship. 

4. In the Create Relationship dialog box, click the down arrow for Table, and select a table 

from the dropdown list. In a "one-to-many" relationship, this table should be on the "many" 

side. 

5. For Column, select the column that contains the data that is related to Related Lookup 

Column. The column is automatically selected if you right-clicked on a column to create the 

relationship. 

6. For Related Lookup Table, select a table that has at least one column of data that is related 

to the table you just selected for Table. In a "one-to-many" relationship, this table should be 

on the "one" side, meaning that the values in the selected column do not contain duplicates. If 

you attempt to create the relationship in the wrong order (one-to-many instead of many-to-

one), an icon will appear next to the Related Lookup Column field. Reverse the order to 

create a valid relationship. 

7. For Related Lookup Column, select a column that has unique values that match the values 

in the column you selected for Column. 

8. Click Create. 

II. to create a relationship between two tables in Data View 

1. In Visual Studio with Analysis Services projects, click the Table menu, and then click Create 

Relationships. 

2. In the Create Relationship dialog box, click the down arrow for Table, and select a table 

from the dropdown list. In a "one-to-many" relationship, this table should be on the "many" 

sides. 

3. For Column, select the column that contains the data that is related to Related Lookup 

Column. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

4. For Related Lookup Table, select a table that has at least one column of data that is related 

to the table you just selected for Table. 

In a "one-to-many" relationship, this table should be on the "one" side, meaning that the 

values in the selected column do not contain duplicates. If you attempt to create the 

relationship in the wrong order (one-to-many instead of many-to-one), an icon will appear 

next to the Related Lookup Column field. Reverse the order to create a valid relationship. 

5. For Related Lookup Column, select a column that has unique values that match the values 

in the column you selected for Column. 

6. Click Create.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -4 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

1. Write the two methods of relationship? 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 12 points            Unsatisfactory - below 12 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-5 Adding and modifying data in a table  

 

It is possible to modify the design of your table and fields at any time by going to design view and 

making the required changes. However, any changes made after data has been added to the table 

may cause loss of data. Changes to field names, data types and properties may also impact on 

other objects which are linked to or based on the table.  

 

5.1. Adding and removing fields  

You can modify the structure of your table by adding and removing fields in design view. Note, 

however, that using the cut, paste or delete functions will remove the field and any data in that 

field.  

 

I. Selecting fields  

To select a field, click on the row selector to the left of the field name. To select multiple fields, 

click on the row selector and drag the mouse down the selector symbols to select additional 

fields. The screen capture below shows a table with two fields selected 

.  

II. Deleting fields  

1. Select the field or fields to be deleted using the row selector.  

2. Press the Delete key on the keyboard, select Delete Rows from the Design tab or right-

click on the row selector and choose Delete Rows.  

 

III. Inserting fields  

1. Click in the field above which you wish to insert a new row. To insert multiple rows, select 

the required number of rows using the row selector.  

2. Select Insert Rows from the Design tab or right click and choose Insert Rows.  

 

I. Moving fields  

1. Select the field or fields to be moved.  



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

2. Click on the selected field(s) and drag the mouse to the new location for the field(s). As you 

drag, a bold black line will appear indicating where the fields will be moved to if you release 

the mouse button.  

3. Release the mouse button in the appropriate location.  

 

Helpful hint: Don‘t use cut and paste to move fields if you have data in the table as this   will 

delete the data.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -5 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

1. Write the steps how you insert your table? 6 points 

2. Write the steps how you move fields? 6 points 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 12 points            Unsatisfactory - below 12 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet 6 Adding and deleting records 

 

Adding a new record to a table. 

1. Click the on the Record Navigation bar, as shown in Figure. 

2. Enter your last name in the Last Name field. 

3. Press Tab to move to the next field and enter your first name. 

4. Complete the record by entering your own information into each respective field (enter 

today's date for the hire date). Remember to press Tab to move to the next field. 

5. Position the mouse over the left edge of the Title cell in your record (the  pointer changes to 

a ) and then click to select the cell. 

6. Type inside Sales Coordinator. 

7. When you have finished making the change, press Tab. 

8. Place the insertion point anywhere in the record you just added. 

9. Click yes to confirm the deletion and then close the table. 

Helpful Editing Keys 

Key(s) Description 

Tab or Enter 

Moves to the next field in the table. If you're at the last field or cell in a table, 

pressing Tab or Enter will save your changes and move to the first field in the next 

record. 

Esc 
The is the "Wait, I've changed my mind" key. Press Esc to cancel any changes 

you've made to a record. 

, , , 

or » 

Use the to move between fields and records. If you are editing a field, pressing the 

left and right arrow keys will move the insertion point one character to the left or 

right. 

Delete 

Nothing surprising here. The deletes or erases whatever is selected text, cell 

contents, even entire records. If you're working with text, the Delete key erases 

characters to the right of the insertion point. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Key(s) Description 

Backspace 
Use the to fix your typing mistakes it erases characters to the left of the insertion 

point. 

 

To add a new record: 

1. Click the new record navigation button. 

Or... 

Click the new record button on the toolbar. 

Or... 

Press ctrl + +. 

2. Enter the record information for the field, pressing tab to move to the next field and shift + 

tab to move to the previous field. 

To edit a record: 

 Click the field you want to edit and make the changes. 

To delete a record: 

 Place the insertion point anywhere in the record and click the delete record button on the 

toolbar. 

To delete a database field 

You can delete a database field only if no datasheets, spreadsheets, or pedigrees are open. If any 

of these items are open, right-click on the item‘s tab and click Close Tab. You can then continue 

with deleting database fields. 

1. On the navigation bar, click the Fields button. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

a. The Fields window opens. 

2. In the left pane of the window, on the Main tab, select the folder that contains the field 

that you are deleting. 

b. A list of the fields that are contained in the folder is displayed in the right pane of the 

Fields window. 

3. Right-click on the field that you are deleting (CTRL-click to select multiple fields), and on 

the context menu that opens, click Delete Field. 

c. A message opens asking you if you are sure that you want to delete the selected fields 

and that the operation will delete the fields and the data. 

4. Click OK.  The message closes and the field (and the data stored in the field) is deleted 

from the database. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -6 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

1. List and describe the helpful editing keys? 10 points 

2. Write the steps to adding a new record to a table.10 points 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 20 points            Unsatisfactory - below 20 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet-6 Adding a new records to a table 

 

Steps to adding a new record to a table. 

1. Click the on the Record Navigation bar, as shown in Figure. 

2. Enter your last name in the Last Name field. 

3. Press Tab to move to the next field and enter your first name. 

4. Complete the record by entering your own information into each respective field  

5. Position the mouse over the left edge of the Title cell in your record  

6. Type inside Sales Coordinator. 

7. When you have finished making the change, press Tab. 

8. Place the insertion point anywhere in the record you just added. 

9. Click yes to confirm the deletion and then close the table. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________   Time finished:  ________________ 

                   Instruction: Given necessary templates, tools and materials you are required to perform the 

following tasks within 1 hours. 

Task 1. Create Excel database 

Task 2. Add a new records to a table  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LAP Test  Practical Demonstration 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

https://www.wikihow.com/Create-a-Database-from-an-Excel-Spreadsheet 

https://support.office.com/en-us/article/ways-to-add-edit-and-delete-records-5e90a80c-106d-4c55-

996e-07d7200980ce 

IT training manuals 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

List of reference and materials 
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Instruction sheet Learning Guide #15 

 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics –  

 Designing reports  

 Modifying reports  

 Distributing reports  

 Using a wizard  

 modifying records  

This guide will also assist you to attain the learning outcome stated in the cover page. Specifically, 

upon completion of this Learning Guide, you will be able to – 

 Design reports to present data in a logical sequence 

 Modify reports to include or exclude additional requirements 

 Distribute reports to appropriate person in a suitable format 

 Use a wizard to create a simple form 

 Open existing database and modify records through a simple form 

 Rearrange objects within the form to accommodate information requirements 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide. 

2. Follow the instructions described below 3 to 5. 

3. Read the information written in the information ―Sheet 1 to Sheet 3. 

4. Accomplish the ―Self-check1 to Self-check 3 in page -191, 195 and 198 respectively. 

5. If you earned a satisfactory evaluation from the ―Self-check‖ proceed to the next. 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-1 Designing and Modifying  reports  

 

1.1  Report 

Report is a document that presents information in an organized format for a specific audience and 

purpose. Although summaries of reports may be delivered orally, complete reports are almost always 

in the form of written documents 

1.2  Basic structure of a report 

Types of reports can vary greatly; they can range from an experimental report to an environmental 

impact statement. There is however, a basic structure common to most reports, irrespective of their 

type.  

1.2.1 Major components of a general report 

Title Page 

Abstract 

 In less than 200 words ... what was the problem, how was it investigated, what did you find out 

and what do your findings mean? 

Table of Contents 

 A list of the major and minor sections of your report. 

Introduction 

 Set the scene; give some background information about the topic. State the aim/purpose of the 

investigation. Outline the body sections. 

Main Body 

 Organize the sections in a logical sequence: what you investigated, what you found, what 

interpretations and what judgements you made. Use short informative headings and 

subheadings. 

javascript:void(0)


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Conclusion 

 What has been achieved and what is the significance of your findings and your discussion? 

Have your aims been successful or not? 

Recommendations 

 What do you recommend as a course of action following your conclusion? 

References 

 A list of all the sources you used. 

Appendices 

 Any information (graphs, charts, tables or other data) you used in your report but did not include 

in the body. 

1.3 Modify your report in Layout view 

This section describes some of the common report modifications that you can perform in Layout view. 

Change column or field width in Layout view 

1. Click an item in the column that you want to adjust. 

A border is drawn around the item to indicate that the field is selected. 

2. Drag the right or left edge of the border until the column is the width you want. 

Change row or field height in Layout view 

1. Click an item in the row that you want to adjust. 

A border is drawn around the item to indicate that the field is selected. 

2. Drag the top or bottom edge of the border until the row is the height you want. 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

1. What are the basic structures of reports? 10 points 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name ________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 10 points            Unsatisfactory - below 10 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-2 Using a wizard for create a simple form 

 

A wizard is a piece of software that simplifies complicated tasks, or instructs a user about how to 

complete a task. As a particular kind of user interface, the software wizard could be called a "digital 

tutorial" or "online (or desktop) guide" that helps users to accomplish their goals 

When you create a report, you can either use the Report Wizard to assist you or create the report 

yourself. To build the form letter report in this example, you can use the Report Wizard. Using the 

wizard enables you to define the layout for the report, as well as set the data definition. 

In the Report Wizard, on the Text page, you will be able to set up your form letter report exactly the 

way you want it to appear. On this page of the wizard, you can set up your boilerplate text (for 

example, the body of the letter), and use the fields from your data tables to fill in the variable data (for 

example, the addressee's name). 

2.1. To create a form letter report: 

1. Launch Reports Builder (or, if already open, choose File > New > Report) 

2. In the Welcome or New Report dialog box, select Use the Report Wizard, then click OK. 

3. If the Welcome page displays, click next. 

4. On the Report Type page, select Create Paper Layout Only, then click next. 

5. On the Style page, type a Title for your report, select Form Letter, then click next. 

6. On the Data Source page, click SQL Query, then click next. 

7. On the Data page, enter the following SELECT statement in the Data Source definition field: 

 Note: You can enter this query in any of the following ways: 

 Copy and paste the code from the provided text file called formletter_code.txt into the Data 

Source definition field. 

 Click Query Builder to build the query without entering any code manually. 

 Type the code in the Data Source definition field. 

8. Click Next. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

9. On the Text page, format the letter the way you want it to appear. The steps that follow will 

show you how to make your form letter report look like this: 

Employee: &<FIRST_NAME> &<LAST_NAME> 

Emp. #: &<EMPLOYEE_ID> 

Dear &<FIRST_NAME> &<LAST_NAME>: 

The Human Resources department is updating its records of the company's employees. Currently, our 

records show your employee number as &<EMPLOYEE_ID>, and that you hold the position of 

&<JOB_TITLE>. If any of this information is incorrect, please contact the Human Resources 

department. 

10. In the Form Letter Text box, type Employee: 

11. Click Space four times to enter four spaces. 

12. In the Available Fields list, click FIRST_NAME, then click the right arrow (>) to move this field 

to the Form Letter Text field. 

13. In the Available Fields list, click LAST_NAME, then click the right arrow (>). 

14. Click New Line. 

15. In the Form Letter Text field, type Emp. #. 

16. Click Space four times to enter four spaces. 

17. In the Available Fields list, click EMPLOYEE_ID, then click the right arrow (>). 

18. Click New Line twice. 

19. In the Form Letter Text field, type Dear. 

20. Click Space. 

21. In the Available Fields list, click FIRST_NAME, then click the right arrow (>). 

22. In the Available Fields list, click LAST_NAME, then click the right arrow (>). 

23. In the Form Letter Text field, type a colon (:) next to LAST_NAME, then click New Line twice. 

24. Type the body of the letter. For the field names, use the Available Fields list to select the 

appropriate name, then click the right arrow (>) to insert it into the Form Letter Text field. The 

result should look like this: 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

The Human Resources department is updating its records of the company's employees. 

Currently, our records show your employee number as &<EMPLOYEE_ID>, and that you hold 

the position of &<JOB_TITLE>. If any of this information is incorrect, please contact the Human 

Resources department. 

25. Click Next. 

26. On the Template page, select Predefined Template and click Beige, then click Finish to 

display your report output in the Paper Design view. It should look something like this: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

1. What is wizard? 4 points 

2. How you create a form of report letter by using wizard? 8 points 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 12 points            Unsatisfactory - below 12 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-3 Opening and modifying the existing database and records 

 

The Database Modification is generation of SQL script that leads your database to the current state of 

your diagram. Please note: Database modification usually causes multiple complex statements 

for database structure modification. Once you have changed your diagram, it's usually necessary to 

apply these changes to your database. It's easy to do with the Database Modification tool. 

The Database Modification is generation of SQL script that leads your database to the current state of 

your diagram. 

3.1. Edit data in a text box or field 

Access provides one text control for use with Short Text and Long Text (also called Memo) fields. 

Typically, you can tell if the underlying field is short or long text by the size of the control, which usually 

reflects the size needed for the underlying table field. A Short Text field can store up to 255 characters 

and a Long Text field can store 64,000 characters. By design, you cannot edit data from some types of 

queries.  For example, you cannot edit the data returned by a crosstab query, and you cannot edit or 

remove calculated fields — values that a formula calculates as you use your database, but that do not 

reside in a table. 

1. Open the table or query in Datasheet View or form in Form View. 

2. Click the field or navigate to the field by using the TAB or arrow keys, and then press F2. 

3. Place the cursor where you want to enter information. 

4. Enter or update the text that you want to insert. If you make a typing mistake, press BACKSPACE. 

5.  If a field has an input mask 

6. To be more productive, learn the following shortcut keys: 

- To insert a new line in a text field, press Ctrl+Enter. 

- To insert the default value for a field, press Ctrl+Alt+Spacebar. 

- To insert the current date in a field, press CTRL+SEMICOLON. 

- To insert the current time, press CTRL+SHIFT+COLON (). 

- To check spelling, press F7. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

- To reuse similar values of a previous record, move to the corresponding field in the previous 

record, and then press CTRL+' (apostrophe). 

- To explicitly save your changes, press Shift+Enter. 

7.  To save the data, on the Home tab, in the Records group, click Save Record, or press Shift+ 

Enter. 

You don't have to explicitly save your changes. Access commits them to the table when you move 

the cursor to a new field in the same row, when you move the pointer to another row, or when you 

close the form or datasheet.  

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

1. How you modify your databases? 10 points 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 10 points            Unsatisfactory - below 10 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

https://www.google.com/search?q=Report&oq=Report&sourceid=chrome&ie=UTF-8  

https://www.google.com/search?q=modify+your+database&oq=modify+your+database&sourceid=chro

me&ie=UTF-8 
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https://www.google.com/search?q=Report&oq=Report&sourceid=chrome&ie=UTF-8
https://www.google.com/search?q=Report&oq=Report&sourceid=chrome&ie=UTF-8
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Instruction sheet Learning Guide #16 

 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics –  

 Accessing the existing database and locating  records 

 Creating simple query  

 Developing query with multiple criteria  

  retrieving information 

 Selecting and displaying data  

This guide will also assist you to attain the learning outcome stated in the cover page. Specifically, 

upon completion of this Learning Guide, you will be able to – 

1.  Access existing database and locate required records 

2. Create simple query and retrieve required information 

3. Develop query with multiple criteria and retrieve required information 

4. Select data and display appropriately 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide. 

2. Follow the instructions described below 3 to 6. 

3. Read the information written in the information ―Sheet 1 to Sheet 3. 

4. Accomplish the ―Self-check1 to Self-check 3 in page -204, 213 and 217 respectively. 

5. If you earned a satisfactory evaluation from the ―Self-check‖ proceed to ―Operation Sheet 1 and 

2 in page -205 and 214 respectively. 

6. Do the ―LAP test‖ in page – 218 (if you are ready).  

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-1 Locating existing database  

 

1.1. Open an existing database 

To open an existing database from the Getting Started window, follow these steps: 

1. Click More… under the Open options. The Open dialog box appears (see Figure 1.) 

 

                         Figure 1: The Open dialog box. 

2. If necessary, open the Look In drop-down list box to select another drive or directory. 

3. Click to select the filename of the database you want to open. 

4. Click Open. Access opens the database. 

To open a recently used database from the Getting Started window, follow these   steps: 

1. Locate the database in the list of files in the Getting Started window. 

2. Click the link to the desired database. Access opens the database. 

To open an existing database from the File menu, follow these steps: 

1. Choose File | Open. The Open dialog box appears (refer to Figure 1). 

2. If necessary, open the Look In drop-down list box to select another drive or directory. 

3. Click to select the filename of the database you want to open. 

4. Click Open. Access opens the database. 

To open a recently used database from the File menu, follow these steps: 

1. Open the File menu. 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

2. Locate the desired database in the list of recently used files at the bottom of the File menu. 

3. Click to select the desired file. Access opens the database. 

 

1.2.  Search for a specific record 

You can search for a specific record in a table or form by using the Find tab in the Find and 

Replace dialog box. This is an effective choice for locating a specific record when the record that you 

want to locate satisfies specific criteria, such as search terms, and comparison operators, such as 

"equals" or "contains" 

1. Open the table or form, and then click the field that you want to search. 

2. On the Home tab, in the Find group, click Find, or press CTRL+F. 

The Find and Replace dialog box appears, with the Find tab selected. 

1. In the Find What box, type the value for which you want to search. 

2. To change the field that you want to search or to search the entire underlying table, click the 

appropriate option in the Look In list. 

3. In the Search list, select all, and then click Find Next. 

When the item for which you are searching is highlighted, click Cancel in the Find and Replace dialog 

box to close the dialog box. Records that match your conditions are highlighted  

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

1. Write steps to open existing database? 5 points 

2. How to search specific records? 5 points 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 10 points            Unsatisfactory - below 10 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet-1 Open an existing database 

 

To open an existing database from the Getting Started window, follow these steps: 

1. Click More… under the Open options. The Open dialog box appears  

2. If necessary, open the Look In drop-down list box to select another drive or directory. 

3. Click to select the filename of the database you want to open. 

4. Click Open. Access opens the database. 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-2 Creating and requiring simple query 

 

2.1. A simple query 

A simple query is a query that searches using just one parameter. A simple query might use all of the 

fields in a table and search using just one parameter. or it might use just the necessary fields about 

which the information is required, but it will still use just one parameter (search criteria) 

 

2.2. Creating a Simple Query in Access 2013 

1. Open Your Database: If you haven't already installed the North wind sample database, be 

sure to do so before proceeding. Open that database. 

2. Switch to the Create Tab: In the Access ribbon, change from the File tab to the Create tab. 

This will change the icons presented to you in the ribbon. If you're not familiar with using the 

Access ribbon, read Access 2013 Tour: The User Interface. 

3. Click the Query Wizard Icon: The query wizard simplifies the creation of new queries. We'll 

use it in this tutorial to introduce the concept of query creation. The alternative is to use the 

Query Design view, which facilitates the creation of more sophisticated queries but is more 

complicated to use. 

4. Select a Query Type. Access will ask you to choose the type of query you wish to create. For 

our purposes, we will use the Simple Query Wizard. Select this and click OK to continue. 

5. Select the Appropriate Table from the Pull-Down Menu: The Simple Query Wizard will 

open. It includes a pull-down menu that should be defaulted to "Table: Customers". When you 

select the pull-down menu, you'll be presented with a listing of all the tables and queries 

currently stored in your Access database. These are the valid data sources for your new query. 

In this example, we want to first select the Products table which contains information about the 

products we keep in our inventory. 

6. Choose the Fields You Wish to Appear in the Query Results: You can do this by either 

double-clicking on them or by single-clicking first on the field name and then on the ">" icon. As 

you do this, the fields will move from the Available Fields listing to the Selected Fields listing. 

Notice that there are three other icons offered. The ">>" icon will select all available fields. The 

"<" icon allows you to remove the highlighted field from the Selected Fields list while the "<<" 

https://www.lifewire.com/installing-northwind-sample-database-access-2013-1019697
https://www.lifewire.com/description-of-ribbon-3123973
https://www.lifewire.com/access-2013-tour-the-user-interface-1019522
https://www.lifewire.com/access-2013-tour-the-user-interface-1019522
https://www.thoughtco.com/create-access-2013-database-from-scratch-1019957
https://www.lifewire.com/manage-data-with-databases-tables-records-and-fields-in-excel-4178649


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

icon removes all selected fields. In this example, we want to select the Product Name, List 

Price, and Target Level from the Product table. 

7. Repeat Steps 5 and 6 to Add Information from Additional Tables, As Desired: In our 

example, we're pulling information from a single table. However, we're not limited to using only 

one table. That's the power of a query! You can combine information from multiple tables and 

easily show relationships. All you have to do is select the fields -- Access will line up the fields 

for you! Note that this works because the North wind database has predefined relationships 

between tables. If you're creating a new database, you'll need to establish these relationships 

yourself. Read the article Creating Relationships in Microsoft Access for more information on 

this topic. 

8. Click on Next: When you're finished adding fields to your query, click the Next button to 

continue. 

9. Choose the Type of Results You Would Like to Produce: We want to produce a full listing of 

products and their suppliers, so choose the Detail option here and click the Next button to 

continue. 

10. Give Your Query a Title: You're almost done! On the next screen, you can give your query a 

title. Select something descriptive that will help you recognize this query later. We'll call this 

query "Product Supplier Listing." 

11. Click on Finish: You'll be presented with the query results shown in the illustration above. It 

contains a list of our company products, desired target inventory levels, and list prices. Notice 

that the tab presenting the results contains the name of your query. 

https://www.lifewire.com/installing-northwind-sample-database-access-2013-1019697
https://www.lifewire.com/creating-relationships-in-microsoft-access-2010-1019960


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

                                Figure 1: how to create queries 

2.3. Information retrieval process  

Information retrieval (IR) is the activity of obtaining information system resources that are relevant to 

an information need from a collection of those resources. Searches can be based on full-text or other 

content-based indexing. Information retrieval is the science of searching for information in a document, 

searching for documents themselves, and also searching for the metadata that describes data, and for 

databases of texts, images or sounds. 

https://en.wikipedia.org/wiki/Information_system
https://en.wikipedia.org/wiki/Full-text_search
https://en.wikipedia.org/wiki/Metadata


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

                                       Figure 1.  Riverview processes 

 

The Process of Information Retrieval. ... The Process of Information Retrieval starts when a user 

creates any query into the system through some graphical interface provided. These user-defined 

queries are the statements of needed information. for example, queries fork by users in search 

engine 

What are two main activities involved in retrieving information? The documents can be books, 

journals, reports, atlases, or other records of thought, or any parts of such records—articles, chapters, 

sections, tables, diagrams, or even particular words. The retrieval devices can range from a bare list 

of contents to a large digital computer and its accessories. 

2.4. Procedure for Retrieving Records 

Records stored in the URC remain the property of the department of origin and can be retrieved at 

your request. This is not the same as records held in the Archives, which have completed a formal 

transfer of ownership to the Archives and so the process to access them is different. 

When you need to retrieve a file or box of records from the URC, you need to: 

1. Check your departmental records in order to clearly identify the files you need to retrieve. 

https://www.sfu.ca/archives/records-management/URC-transfer/URC.html
https://www.sfu.ca/archives/archives-program/research.html#main_content_title
https://www.sfu.ca/archives/records-management/URC-transfer/URC.html


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

2. Contact Records Management and provide complete information about the files you wish to 

retrieve. 

3. Ensure that the files are returned to Records Management when they are no longer needed by 

the department. 

This service is provided to the University community free of charge. 

1. Identify the files you want to retrieve 

Using the file lists and URC location lists filed in your department, locate the: 

- Name, title and/or number of the file to be retrieved; 

- unique, identifying box number of the box the file is contained in; 

- URC shelf location number. 

2.4. Contact Records Management to make your file retrieval request. 

Initiate a retrieval request by contacting the Records Centre Clerk and providing the following 

information: 

- Name and position title of the person making the request; 

- Name of department; 

- Room and telephone number; 

-  Archival box number; 

- Records Center shelf location number; 

- File name, title and/or number. 

Indicate if you will pick-up the item from the Archives and Records Management Office or if you would 

like it delivered. Departments may request delivery service during the Records Centre Clerk‘s shift or 

may pick records up during office hours. 

Regular file retrievals will typically be ready for pick-up or delivery within 48 hours. 

The maximum number of boxes that can be retrieved in one shift is four. If you require more 

than four boxes at one time, you may either: 

- narrow your request to specific files rather that whole boxes; 

- have your boxes delivered over several shifts; 

- place a work order with Facilities Management to have the boxes delivered (for a fee). 

mailto:rcclerk@sfu.ca
https://www.sfu.ca/archives/contact.html#main_content_text
https://www.sfu.ca/archives/contact.html#main_content_text_0


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

You will receive a Records Centre File Charge-Out Form with the retrieved files. Keep this form with 

the files so that they can be returned to the correct location. This form indicates that the named person 

is responsible for the files and for returning them to Records Management. 

2.5 Select data based on multiple criteria 

Example question: 

I have a table called Candy, with thousands of records, and has 10 columns with information about the 

candy. I want to pull up the data for 3 records, and I have the following information: 

1. Candy 1: Color = Yellow, Type = Soft, Flavor = Lemon 

2. Candy 2: Color = Yellow, Type = Hard, Flavor = Lemon 

3. Candy 3: Color = Red, Type = Hard, Flavor = Cherry 

How do I do this? In Psuedo-CodeEnglish, it would be: 

Select * 

From Candy 

WHERE (Color = Yellow, Type = Soft, Flavor = Lemon) 

AND (Candy 2: Color = Yellow, Type = Hard, Flavor = Lemon) 

AND (Color = Red, Type = Hard, Flavor = Cherry); 

But that doesn't work for me. I'm using PL/SQL. 

3 Answers 

The basic idea is that you want to find any row where any line is true, but all conditions on that line are 

true. That means you need something that's of the following structure: ___ OR ___ OR ___ where 

each ___ is itself a list of ands: ___ AND ___ AND ____: 

Select * 

From Candy 

WHERE (Color = Yellow and Type = Soft and Flavor = Lemon) 

Or (Color = Yellow and Type = Hard and Flavor = Lemon) 

Or (Color = Red and Type = Hard and Flavor = Cherry); 

While @Denise's answer is fine, in certain cases there is a better way to solve this type of problem 

using a relational database. If you are doing a single query using a where statement is fine. But you 

https://stackoverflow.com/questions/26539415/sql-select-data-based-on-multiple-criteria


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

might have different requirements. For example, saving queries or storing candy requirements for 

many different users, etc. 

Create a selection table. This table has 3 columns (color, type and flavor) in the same type as your 

candy table. Also add a unique identifier. Then add the following data to the table: 

Id         color    type   flavor 

1         Yellow Soft   Lemon 

2         Yellow   Hard   Lemon 

3         Red      Hard   Cherry 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

1. What is simple query? 5 points 

2. How to create simple query in access 2013? 5 points 

3. What is Information retrieval? 5 points 

4. Write the processes of Information retrieval. 10 points 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________ 

Answer sheet 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 25 points            Unsatisfactory - below 25 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet-2 Creating and requiring simple query 

 

Steps to Creating a Simple Query 

1. Open Your Database 

2. Switch to the Create Tab  

3. Click the Query Wizard Icon  

4. Select a Query Type 

5. Select the Appropriate Table from the Pull-Down Menu 

6. Choose the Fields You Wish to Appear in the Query Results 

7. Repeat Steps 5 and 6 to Add Information from Additional Tables, As Desired  

8. Click on Next 

9.  Choose the Type of Results You Would Like to Produce 

10. Give Your Query a Title  

11. Click on Finish 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-3 Selecting data and displaying 

Select query 

Select query is used to retrieve data from a table. It is the most used sql query. We can retrieve 

complete table data, or partial by specifying conditions using the where clause. 

Syntax of select query 

Select query is used to relieve records from a table. We can specify the names of the columns which 

we want in the result set. 

SELECT  

    column_name1,  

    column_name2,  

    column_name3,  

    column_nameN  

    FROM table_name; 

Time for an Example 

Consider the following student table, 

s_id Name Age Address 

101 Birhanu 15 Adishihu 

102 Alex 18 Maichew 

103 Selamawit 17 Asosa 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Displaying Data 

Once your users have submitted some information that has become things, you can have some 

elements in the page to display them. Some elements in the page can have a thing in their context, 

that you define in the editor (see below), and then other elements in the page will be able to refer to an 

element's thing. In other words, you can attach a thing (an object from the database) to an element, 

and have other elements access this thing to display some values or fields relative to this thing. 

  
Figure 1. Data displaying in word and Excel 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

1. What is data display? 5 points 

 

 

You can ask your teacher for the copy of the correct answers 

 

 

Name:  _________________________             Date:  _______________ 

Answer Sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 5 points            Unsatisfactory - below 5points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________   Time finished:  ________________ 

                        Instruction: Given necessary templates, tools and materials you are required to perform the 

following tasks within 30 minutes. 

           Task 1. Create a simple query 

           Task 2. Open an existing database 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LAP Test  Practical Demonstration 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

https://www.google.com/search?q=Create+a+simple+query&oq=Create+a+simple+query&sourceid=c

hrome&ie=UTF-8  

https://www.google.com/search?q=Open+an+existing+database&oq=Open+an+existing+database&so

urceid=chrome&ie=UTF-8  

 

 

 

 

 

 

 

 

 

 

 

 

List of reference and materials 
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This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics –  

 Previewing documents 

 Selecting basic print settings 

 Printing document 

This guide will also assist you to attain the learning outcome stated in the cover page. Specifically, 

upon completion of this Learning Guide, you will be able to – 

 Preview document/ spread sheet in print preview mode 

 Select basic print settings/ options  

 Print document/spread sheet or part of document/ spread sheet from printer 

 Submits the spread sheet to appropriate person for approval or feedback 

Learning Instructions:  

                  1.  Read the specific objectives of this Learning Guide. 

                  2. Follow the instructions described below 3 to 6. 

                  3. Read the information written in the information ―Sheet 1 and Sheet 2. 

                 4. Accomplish the ―Self-check1 and Self-check 2 in page -224 and 227 respectively. 

5. If you earned a satisfactory evaluation from the ―Self-check‖ proceed to ―Operation 

Sheet 1 in page -228. 

6. Do the ―LAP test‖ in page – 229 (if you are ready). 

Instruction sheet Learning Guide #01 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-1 Previewing document/ spread sheet 

Preview worksheet pages before you print 

When you select one or more sheets and then click File > Print, you'll see a preview of how the 

data will appear on the printout. 

1. Select the worksheet(s) you want to preview. 

2. Click File, and then click Print to display the Preview window and printing options. 

 

                                 Figure 1: print preview box 

Keyboard shortcut    you can also press Ctrl+F2.   

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Viewing the page layout 

 

                      Figure 2. View the document/spread sheet/ before print 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

1. Write how to see your document before print? 

 

 

You can ask your teacher for the copy of the correct answers 

 

 

Name:  _________________________             Date:  _______________ 

Answer Sheet 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 8 points            Unsatisfactory - below 8 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Information sheet-2 Selecting basic print settings/ options 

 

2.1. Printer settings 

 

Access the settings window in Devices and Printers to select settings that apply to all your print 

jobs. 

- Search Windows for 'printers', then click Devices and Printers in the search results. 

- Right-click the icon for your printer, then click Printer properties. ... 

- Click the Advanced tab, then click Printing Defaults 

2.2. Printer Driver Settings Access 

The printer driver software can be accessed from the Print dialog box of an application, or from 

Start. If accessed from an application, then changes made to driver settings remain in effect until 

the application ends. If accessed from Start, changes are maintained as the default printer 

settings. 

Changing the Default Driver Settings 

The Reset button is only available when you access Preferences or Properties from the Print 

dialog box of an application. Default driver settings apply to printing jobs initiated from any 

application, but they are overridden by setting changes made within each application. 

1.  Click Start and click Devices and Printers (Windows 7), or click Control Panel 

And double-click Printers (Windows Vista), or Printers and Faxes (Windows 

2. XP). 

3. Right-click on your printing system icon. 

4. Click Printing Preferences. 

5. In the Printing Preferences dialog box, select the desired features in all tabs. 

6.  Click OK to save the settings. 

2.3. Selecting Basic Print Settings  

Select the basic settings for the document or photo you want to print. 

1. Open a photo or document for printing. 

2. Select the print command in your application. 

3. Select your product as the Printer setting. 

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the print 

window. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

        

                                                          Figure 2: print setting window 

 

5. Select the Copies and Pages settings as necessary. 

Note: If you do not see these settings in the print window, check for them in your application 

before printing. 

6. Select the page setup options: Paper Size and Orientation. 

Note: If you do not see these settings in the print window, check for them in your application 

before printing. They may be accessible by selecting Page Setup from the File menu. 

7. Select any application-specific settings that appear on the screen, such as those shown in the 

image above for the Preview application. 

8. Select Print Settings from the pop-up menu. 

 

9. Select the type of paper you loaded as the Media Type setting. 

Note: The setting may not exactly match the name of your paper. Check the paper type 

settings list for details. 

10. Select the Print Quality setting you want to use. 

11. Select any of the available print options. 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

1. Write a procedure how to set your documents before print? 

 

 

You can ask your teacher for the copy of the correct answers. 

 

 

Name:  _________________________             Date:  _______________  

Answer sheet  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 6 points            Unsatisfactory - below 6 points 

  

Yo can ask you teacher for the copy of the correct answers. 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

Operation sheet -2 Selecting Basic Print Settings  

 

Steps to select the basic settings for the document or photo you want to print. 

1. Open a photo or document for printing. 

2. Select the print command in your application. 

3. Select your product as the Printer setting. 

4. If necessary, click the arrow next to the Printer setting         

5. Select the Copies and Pages settings as necessary. 

6. Select the page setup options: Paper Size and Orientation. 

7. Select any application-specific settings that appear on the screen, such as those shown in the 

image above for the Preview application. 

8. Select Print Settings from the pop-up menu. 

9. Select the type of paper you loaded as the Media Type setting. 

10. Select the Print Quality setting you want to use. 

11. Select any of the available print options.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________   Time finished:  ________________ 

                   Instruction: Given necessary templates, tools and materials you are required to perform the 

following tasks within 30 minutes. 

Task 1. Select basic Print Settings 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LAP Test  Practical Demonstration 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

https://www.google.com/search?q=Select+basic+Print+Settings&oq=Select+basic+Print+Settings&

sourceid=chrome&ie=UTF-8 

https://www.google.com/search?q=printing+decuments&oq=printing+decuments&sourceid=chrome

&ie=UTF-8  

IT training manuals  

 

List of reference and materials 

https://www.google.com/search?q=printing+decuments&oq=printing+decuments&sourceid=chrome&ie=UTF-8
https://www.google.com/search?q=printing+decuments&oq=printing+decuments&sourceid=chrome&ie=UTF-8


                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

 

 

 

  



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 

Profile of trainers participate on special Horticultural Crops Production TTLM development for     

level I at Adama 2020

NO TTLM developer 
Name 

Back ground 
Qualification 

 

College  
Address  

College  
Name 

Cell Phone E-mail  

1 
 

Deribow Gonfa Plant 
science(Bsc) 

Oromiya Fitche 
PollyTVET 

0912774688 gonfad24@gmail.com 

2 Tesfaye Tekola Agronomy (Msc) Benishangul 
Gumuz 

Assosa 
ATVET 

0910550651 
 

tttekola@gmail.com 

3 Berhanu Mammo Horticulture (BSc) Mizan ATVET Federal 0912676883 birehanmammo@gmail.com 

4 Haftu Mehari Plant 
science(BSc) 

Tigray Maichew 
ATVET 

0914312311 Kalabkalab61@gmail.com 

5 Melaku  Bawoke Agronomy (Msc) Federal Gewane  0920258287 Melakubawoke10@gmail.com 

6 Tadesse Yasin Horticulture (BSc) Amhara Kombolcha  
PollyTVET 

0921626541 tadaseyasin2019@gmaio.com 

7 Zewde Paulos Agronomy(Msc) SNNPR Sodo ATVET 0921004814 Zedpa2013@gmail.com 

8 Bekele Belete Agronomy (Msc) SNNPR Sodo ATVET 0916379025 Bekelebelete6@gmail.com 

9 Fetene Muluken Agronomy (Msc) Amhara Woreta 
ATVET 

0986911690 Fetenemuluken9@gmail.com 

10 Misgana Belay Agronomy (Msc) Oromia  Nedjo 
ATVET 

0911983854 Misbel2000@gmail.com 

11 
 

Sadik Ebrahim Agronomy (Msc) Federal Agarfa 
ATVET 

0920617776 sadikebra@gmail.com 

12 Birhanu reda Horticulture(BSc) Tigray Maichew 
ATVET 

0923452395 birhanureda@gmail.com 



                                                                                                                                                                                                                                                                                                                                                

                                                                                                      

 


